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Preface

Welcome to Mastering ArcGIS Pro, a detailed primer on learning the latest ArcGIS™ software 
by Esri®, Inc. This book is designed to offer everything you need to master the basic elements 
of GIS.

Notice: ArcGIS Pro™, ArcGIS™, ArcMap™, ArcCatalog™, ArcGIS Desktop™, ArcInfo 
Workstation™, and the other program names used in this text are registered trademarks 
of Esri®, Inc. The software names and the screen shots used in the text are reproduced by 
permission. For ease of reading, the ™ symbol has been omitted from the names; however, no 
infringement or denial of the rights of Esri® is thereby intended or condoned by the author.

A new text for a new GIS experience
Although the concepts of GIS have remained fairly constant over time, the software is continually 
evolving. With the release of ArcGIS Pro, the latest software in the Esri GIS family, a new gener-
ation of GIS has arrived. ArcGIS Pro has a 64-bit, multithreaded architecture, uses ribbon-style 
menus, integrates 2D and 3D applications, and is closely tied to ArcGIS Online. 

The Mastering ArcGIS Pro series represents a major revision of Mastering ArcGIS, a book that 
covered GIS concepts and skills using the ArcGIS Desktop programs of ArcMap and ArcCata-
log. Although the GIS concepts largely remain the same in both texts, the implementation, and 
in some cases the terminology, has changed. The new software prompted a reorganization of 
the book in the first edition, and the second edition has retained these changes. 

First, the book has been refocused on the basics of GIS. Partly for this reason, and partly to 
better match the rhythm of a semester, the book is now presented in 12 chapters, leaving time 
for instructors to better incorporate exams and projects within the semester. Some of the more 
advanced and less frequently used skills, such as planar topology and standards-based metadata, 
have been left for students to explore on their own. The ArcGIS Pro software capabilities and 
interface are continuing to evolve. Although the basic capabilities of ArcGIS Pro have not much 
changed since the first edition, the interface has many small changes. This second edition has 
been updated to reflect many small changes to the interface between versions 2.2 and 2.8. 

Second, the book includes some new topics. Raster data management has been discussed in a 
new chapter to acquaint students with compiling and processing raster data sets, supplementing 
a similar chapter on vector data management. ArcGIS Pro was designed to foster the sharing of 
GIS data and workflows, and these enhanced capabilities are explored in another new chapter, 
including how to prepare a database for collecting data using mobile devices.

Third, the chapters and topics have been reorganized to eliminate some repetition and to present 
the information more logically. The text still roughly follows the project model with data manage-
ment presented first and analysis second.

The tutorials, questions, and exercises were rewritten in the first edition. The second edition edits 
mainly deal with the many small changes to the interface. Some of these changes are minor but 
ubiquitous (such as the change of a button name). In such cases I have changed the text and the 
first video or two to reflect the differences, but left subsequent videos unchanged. 

In the first edition, I have tried to incorporate more open-ended and creative questions in the 
exercises, rather than relying on cut-and-dried questions and answers. Although this approach 
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makes grading a little harder for instructors, I believe it enhances student learning and makes the 
exercises more interesting. The second edition questions and exercises have remained the same. 
The data distributed with the text have not changed from the first edition.

I would like to thank the many people who have used and commented on Mastering ArcGIS, 
and I have tried to take those lessons to heart. I hope that this text continues to serve their needs 
in the rapidly evolving world of GIS.

Previous experience
This book assumes that the reader is comfortable using Windows™ to carry out basic tasks such 
as copying files, moving directories, opening documents, exploring folders, and editing text and 
word processing documents. Previous experience with maps and map data is also helpful.  
No previous GIS experience or training is necessary to use this book.

Elements of the package
This learning system includes a textbook and web site, including

‣‣ Twelve chapters on important concepts in GIS data management and analysis

‣‣ Comprehensive tutorials in every chapter to learn the skills, with each step demonstrated 
in a video clip

‣‣ A set of exercises and data for practicing skills independently

This book assumes that the student has access to ArcGIS Pro and an organizational account for 
ArcGIS Online. The Spatial Analyst extension is required for Chapter 11. 

Philosophy
This text reflects the author’s personal philosophies and prejudices developed from 25 years of 
teaching GIS at an engineering school. The main goal is not to train geographers but to provide 
students in any field with GIS skills and knowledge. It is assumed that most students using this 
book already have a background of discipline-specific knowledge and skills upon which to draw 
and are seeking to apply geospatial techniques within their own knowledge domains.

‣‣ Concepts and skills are both important. Students must be able to understand the  
geographic and database concepts that are integral to spatial data management and  
analysis. It is not enough to know a series of software steps; one should understand the 
“why” behind them.

‣‣ GIS is best learned by doing it. The tutorials constitute a critical component of the 
book, integrating theory with practical experience and promoting a hands-on, active 
learning environment. 

‣‣ Independent work and projects are critical to learning GIS. This book includes exercises 
that encourage students to find solutions independently without a cookbook recipe of 
steps. A wise instructor will also require students to develop an independent project.

Chapter sequence
The book contains an introduction and 12 chapters. Each chapter includes roughly one 
week’s work for a three-credit semester course. An introductory chapter describes GIS 
and gives some examples of how it is used. It also provides an overview of GIS project 
management and how to develop a project. Chapters 1 through 11 follow a roughly proj-
ect-based sequence: mapping basics, data compilation and management, and spatial analysis. 
The final chapter explores sharing GIS work with others. These chapters are the core of an 
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introductory GIS class and, by the end of it, students should have little difficulty developing 
and carrying out an independent GIS project. 

Chapter layout
Each chapter is organized into the following sections:

‣‣ Concepts: provides basic background material for understanding geographic concepts 
and how they are specifically implemented within ArcGIS. Most chapters have two 
sections, one (About GIS) covering general GIS concepts and theory, and another (About 
ArcGIS) covering the specific implantation of those concepts within ArcGIS Pro. A set of 
review questions and important terms follows the Concepts section.

‣‣ Tutorial: contains a step-by-step tutorial demonstrating the concepts and skills. The tuto-
rials begin with detailed instructions, which gradually become more general as mastery 
is built. Every step in the tutorial is demonstrated by accompanying video clips.

‣‣ Exercises: presents a series of problems to build skill in identifying the appropriate tech-
niques and applying them without step-by-step help. Through these exercises, the student 
builds an independent mastery of GIS processes. Brief solution methods are included for 
all exercises, and maps of the results are shown when applicable. A full answer and meth-
ods document is available for instructors at the McGraw-Hill Instructor web site.

The book web site, http://www.mhhe.com/Price_pro2e, also contains all the data needed to follow 
the tutorials and complete the exercises. 

Instructors should use judgment in assigning exercises. The typical class would be stretched to 
complete all the exercises in every chapter. Very good students can complete an entire chapter in 
3 to 6 hours, most students would need 6 to 8 hours, and a few students would require 10 or more 
hours. Students with more computer experience generally find the material easier than others.

Using this text
In working through this book, the following sequence of steps is suggested: 

‣‣ READ through the Concepts sections to get familiar with the principles and techniques.

‣‣ ANSWER the Chapter Review Questions to test comprehension of the material.

‣‣ WORK the Tutorial section for a step-by-step tutorial and explanation of key techniques.

‣‣ REREAD the Concepts section to reinforce the ideas. 

‣‣ PRACTICE by doing the Exercises.

Using the tutorial
The tutorial provides step-by-step practice and introduces details on how to perform specific 
tasks. Students should be encouraged to think about the steps as they are performed and not just 
race to get to the end. 

It is important to follow the directions carefully. Skipping a step or doing it incorrectly may result 
in a later step not working properly. Saving often will make it easier to go back and correct a 
mistake in order to continue. Occasionally, a step will not work due to differences between com-
puter systems or software versions. Having an experienced user nearby to identify the problem 
can help. If one isn’t available, however, just skip the step and move on without it.
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Using the videos
The digital version of this text contains videos of each tutorial step. They are numbered in the text 
for easy reference. The videos are intended as an alternate learning strategy. It would be tedious 
to watch all of them. Instead, use them in the following situations:

‣‣ When a student does not understand the written instructions or cannot find the correct 
menu or button

‣‣ When a step cannot be made to work properly

‣‣ When a reminder is needed to do a previously learned skill in order to complete a step

‣‣ When a student finds that watching the videos enhances learning

Using video and data components

To view the videos:

The videos are embedded in the electronic version of the text and will take users to the online 
learning center for viewing. Each chapter may be downloaded separately. 

To install the training data:

The gisclass_Pro2e.zip archive contains a folder with the documents and data needed to do the 
tutorials and exercises. Students must extract this folder to their own hard drives. If more than 
one person on the computer is using this book, then each person should make a personal copy of 
the data in a separate folder. The data require approximately 360 MB of disk space.

Extracting the zip file creates a folder named gisclass. It should be extracted to a location on the 
C:\drive. Do not install it in a user Documents folder or on the Desktop because GIS data often 
function poorly in those locations. Cloud drives such as GoogleDrive or OneDrive are also not 
recommended for placing GIS data.

System requirements

Hardware:

ArcGIS Pro requires a PC 64-bit multiprocessor machine with at least a dual core, and a quad core 
processor or higher is recommended. Pro requires a minimum of 8 GB of RAM and a good graph-
ics card with at least 2 GB of RAM and 24-bit display color depth. 

For a complete description of the system requirements, consult Esri (http://pro.arcgis.com/en 
/pro-app/get-started/arcgis-pro-system-requirements.htm).

Software:

Windows 10 (64-bit Home, Pro, or Enterprise) or Windows 8.1 (64-bit Pro or Enterprise)

ArcGIS Pro™ 2.8 or higher (Basic Level); Spatial Analyst extension required for some exercises

A web browser, such as Chrome, Edge, Firefox, or Internet Explorer

A zip utility such as WinZip or 7zip

A media player that can display the .mp4 video format 

Other:

Pro is tightly coupled to ArcGIS Online (AGOL), a cloud-based system built to encourage shar-
ing of GIS data, workflows, and other resources between organizations and users. It is strongly 
recommended that the users have at least a public account, and a subscription account provides 
access to significantly more data and tools. A subscription account with publishing privileges is 
required for some optional exercises in Chapter 12.
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Internet access is required for ArcGIS Pro installation and for exercises requiring the use of  
ArcGIS Online. 

For assistance in acquiring or installing these components, contact your system administrator, 
hardware/software provider, or local computer store.
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Introduction

Objectives

After reading this introduction, you will be able to:

‣‣ Explain what a GIS is and describe some of its operations and uses

‣‣ Start managing GIS projects

‣‣ Plan a sequence of tasks to complete a GIS project

‣‣ Find resources to learn more about GIS

Concepts

What is GIS?

GIS stands for geographic information system. In practical terms, a GIS is a set of computer 
tools that allows people to work with data that are tied to a particular location on the earth. 
Although many people think of a GIS as a computer mapping system, its functions are 
broader and more sophisticated than that. A GIS is a database that is designed to work with 
map data.

Consider the accounting department of the local telephone company. They maintain a large 
computer database of their customers, in which they store the name, address, phone number, 
type of service, and billing information for each customer. This information is only incidentally 
tied to where customers live; they can carry out most of the important functions (billing, for 
example) without needing to know where each house is. Of course, they need to have addresses 
for mailing bills, but it is the post office that worries about where the houses actually ARE. This 
type of information is called aspatial data, meaning that it is not tied, or is only incidentally tied, 
to a location on the earth’s surface.

Employees of the service department, however, need to work with spatial data to provide the 
telephone services. When hundreds of people call in after a power outage, the service department 
must analyze the distribution of the calls and isolate the location where the outage occurred. 
When a construction company starts work on a street, workers must be informed of the precise 
location of buried telephone cables. If a developer builds a new neighborhood, the company 
must be able to determine the best place to tie into the existing network so that the services are 
efficiently distributed from the main trunk lines. When technicians prepare lists of house calls 
for the day, they need to plan the order of visits to minimize the amount of driving time. In these 
tasks, location is a critical aspect of the job, and the information is spatial.

In this example, two types of software are used. The accounting department uses special software 
called a database management system, or DBMS, which is optimized to work with large volumes of 
aspatial data. The service department needs access to a database that is optimized for working with 
spatial data, a geographic information system. Because these two types of software are related, 
they often work together, and they may access the same information. However, they do different 
things with the data.

A GIS is built from a collection of hardware and software components. 

‣‣ A computer hardware platform. Due to the intensive nature of spatial data storage 
and processing, a GIS was once limited to large mainframe computers or expensive 
workstations. Today, it can run on a typical desktop personal computer.
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‣‣ GIS software. The software varies widely in cost, ease of use, and level of functionality 
but should offer at least some minimal set of functions, as described in the next few  
paragraphs. In this book, we study one particular package that is powerful and widely 
used, but others are available and may be just as suitable for certain applications.

‣‣ Data storage. Some projects use only the hard drive of the GIS computer. Other proj-
ects may require more sophisticated solutions if large volumes of data are being stored 
or multiple users need access to the same data sets. Today, many data sets are stored in 
digital warehouses and are accessed by many users over the Internet. Compact disc writ-
ers and/or USB portable drives are highly useful for backing up and sharing data. 

‣‣ Data input hardware. Many GIS projects require sophisticated data entry tools. Digitizer 
tablets enable the shapes on a paper map to be entered as features in a GIS data file. 
Scanners create digital images of paper maps. An Internet connection provides easy  
access to large volumes of GIS data. High-speed connections are preferred because  
GIS data sets may constitute tens or hundreds of megabytes or more.

‣‣ Information output hardware. A quality color printer capable of letter-size prints provides 
the minimum desirable output capability for a GIS system. Printers that can handle map-size 
output (36 in. × 48 in.) will be required for many projects. Today, electronic outputs have 
become common, including PDF files or interactive maps on a web site or a mobile device.

‣‣ GIS data. Data come from a variety of sources and in a plethora of formats. Gathering 
data, assessing their accuracy, and maintaining them usually constitutes the longest and 
most expensive part of a GIS project.

‣‣ GIS personnel. A system of computers and hardware is useless without trained and 
knowledgeable people to run it. The contribution of professional training to successful 
implementation of a GIS is often overlooked. 

GIS software varies widely in functionality, but any system claiming to be a GIS should provide 
the following functions at a minimum:

‣‣ Data entry from a variety of sources, including digitizing, scanning, text files, and the 
most common spatial data formats; ways to export information to other programs should 
also be provided.

‣‣ Data management tools, including tools for building data sets, editing spatial features 
and their attributes, and managing coordinate systems and projections.

‣‣ Thematic mapping (displaying data in map form), including symbolizing map features 
in different ways and combining map layers for display.

‣‣ Data analysis functions for exploring spatial relationships in and between map layers.

‣‣ Map layout functions for creating digital or paper maps with titles, scale bars, north 
arrows, and other map elements.

Geographic information systems are put to many uses, but providing the means to collect, 
manage, and analyze data to produce information for better decision-making is the common 
goal and the strength of each GIS. This book is a practical guide to understanding and using a 
particular geographic information system called ArcGIS, to learn what a GIS is, what it does, and 
how to apply its capabilities to solve real-world problems.

A history of GIS

Geographic information systems have grown from a long history of cartography begun in 
the lost mists of time by early people who made sketches on hides or formed crude models 
of clay as aids to hunting for food or making war. Ptolemy, an astronomer and geographer 
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from the second century B.C., created one of the earliest known atlases, a collection of 
world, regional, and local maps and advice on how to draw them, which remained essentially 
unknown to Europeans until the 15th century. Translated into Latin, it became the core of 
Western geography, influencing cartographic giants, such as Gerhard Mercator, who published 
his famous world map in 1569. The 17th and 18th centuries saw many important developments 
in cartography, including the measurement of a degree of longitude by Jean Picard in 1669, 
the discovery that the earth flattens toward the poles, and the adoption of the Prime Meridian 
that passes through Greenwich, England. In 1859, French photographer and balloonist Gaspard 
Felix Tournachon founded the art of remote sensing by carrying large-format cameras into the 
sky. In an oft-cited early example of spatial analysis, Dr. John Snow mapped cholera deaths 
in central London in September 1854 and was able to locate the source of the outbreak—a 
contaminated well. However, until the 20th century, cartography remained an art and a science 
carried out by laborious calculation and hand drawing. In 1950, Jacqueline Tyrwhitt made  
the first explicit reference to map overlay techniques in an English textbook on town and 
country planning, and Ian McHarg was one of the early implementers of the technique for 
highway planning.

As with many other endeavors, the development of computers inspired cartographers to see what 
these new machines might do. The early systems developed by these groups, crude and slow by 
today’s standards, nevertheless laid the groundwork for modern geographic information systems. 
Dr. Roger Tomlinson, head of an Ottawa group of consulting cartographers, has been called the 
“Father of GIS” for his promotion of the idea of using computers for mapping and for his vision and 
effort in developing the Canada Geographic Information System (CGIS) in the mid-1960s. Another 
pioneering group, the Harvard Laboratory for Computer Graphics and Spatial Analysis, was 
founded in the mid-1960s by Howard Fisher. He and his colleagues developed a number of early 
programs between 1966 and 1975, including SYMAP, CALFORM, SYMVU, GRID, POLYVRT, and 
ODYSSEY. Other notable developers included professors Nystuen, Tobler, Bunge, and Berry from 
the geography department at Washington University during 1958–1961. In 1970, the US Bureau of 
the Census produced its first geocoded census and developed the early DIME data format based 
on the CGIS and POLYVRT data representations. DIME files were widely distributed and were 
later refined into the TIGER format. These efforts had a pronounced effect on the development of 
data models for storing and distributing geographic information.

In 1969, Laura and Jack Dangermond founded the Environmental Systems Research Institute 
(ESRI), which pioneered the powerful idea of linking spatial representation of features with 
attributes in a table, a core idea that revolutionized the industry and launched the development 
of Arc/Info, a program whose descendants have captured about 90% of today’s GIS market. Other 
vendors are still active in developing GIS systems, which include packages MAPINFO, MGA from 
Intergraph, IDRISI from Clark University, and the open-source programs QGIS and GRASS.

What can a GIS do?

A GIS works with many different applications: land use planning, environmental management, 
sociological analysis, business marketing, and more. Any endeavor that uses spatial data 
can benefit from a GIS. For example, researchers at the US Department of Agriculture Rocky 
Mountain Research Station in Rapid City, South Dakota, conducted a study of elk habitat in the 
Black Hills of South Dakota and Wyoming by placing radio transmitter collars on about 70 elk 
bulls and cows (Fig. I.1). Using the collars and a handheld antenna, they tracked the animals and 
obtained their locations. Several thousand locations were collected (Fig. I.1a) for the scientists to 
study the characteristics of the habitat where elk spend time.

The elk locations were entered into a GIS system for record keeping and analysis. Each 
location became a point with attached information, including the animal ID number and 
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the date and time of the sighting. 
Information about vegetation, slope, 
aspect, elevation, water availability, 
and other site factors were derived 
by overlaying the points on other 
data layers, allowing the biologists to 
compare the characteristics of sites 
used by the elk. Figure I.1b shows a 
map of distances to major roads in 
the central part of the study area. The 
elk locations clustered in the darker 
roadless areas, and statistical analysis 
demonstrated this observation 
empirically.

There are many applications of GIS  
in almost every human endeavor, 
including business, defense and 
intelligence, engineering and 
construction, government, health 
and human services, conservation, 
natural resources, public safety, 
education, transportation, utilities, and 
communication. In May 2021, the Solutions section of the ESRI web site at www.esri.com listed 
dozens of application areas in business, government, and industry. Instead of reading through a list 
here, go to the site and see the latest applications.

New trends and directions in GIS

The GIS industry has grown exponentially since its inception. Starting with the mainframe and 
then the desktop computer, GIS began as a relatively private endeavor focused on small clusters 
of specialized workers who spent years developing expertise with the software and data. Since 
then, the development of the Internet and the rapidly advancing field of computer hardware have 
been driving some significant changes in the industry.

Proliferation of options for data sharing

Instead of storing data sets locally on individual computers or intraorganization network 
drives, more people are serving large volumes of data over the Internet to remote locations 
within an organization, across organizations, and to the general public. In the past, large 
collections of data were hosted by various organizations through clearinghouses sponsored 
by the National Spatial Data Infrastructure (NSDI). The data usually existed as GIS data files 
in various formats and required significant expertise and the right software to download 
and use. Today, GIS servers are designed to bring GIS data to the general public with a 
few clicks. Another class of data providers that give wide access to spatial data, although 
not specifically GIS applications, include web sites such as Google Earth, MapQuest, and 
Microsoft Virtual Earth.

Like many other computer industries, GIS is heading for the clouds. A cloud is a gigantic array 
of large computers on which customers rent storage space and processing power, instead of 
purchasing their own physical hardware. ArcGIS Online is a cloud-based platform for users to 
collaborate and share GIS data with each other, making it easy to share data with a colleague, or 
with the world, even for those with no particular GIS expertise. 

Fig. I.1. Analyzing elk habitat use: (a) elk locations 
and study area; (b) locations on a map of distance to 
nearest road; (c) collaring an elk

Courtesy of Mark Rumble
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Proliferation of options for working with GIS data

In the early days, people who wanted to do GIS work had to purchase a large, expensive program 
and learn to use it. Now, a wide variety of scaled applications permits different levels of use 
for different levels of need. Not every user must have the full program. There are web sites for 
people who just need to view and print maps, free download software for viewing interactive map 
publications, and scaled-down versions of the full program with fewer options. 

Many organizations are turning to server GIS as a less expensive alternative to purchasing 
large numbers of GIS licenses. Many workers need GIS, but they only use a small subset of GIS 
functions on a daily basis. A server GIS can provide both data and a customizable set of viewing 
and analysis functions to users without a GIS license. All they need is a web browser. Because of 
more simple and low-cost ways of accessing GIS data and functions, the user base has expanded 
dramatically. These platforms, such as ArcGIS Online, are under constant development and their 
capabilities are expanding at a rapid rate.

Expansion of GIS into wireless technology

More people are collecting and sharing data using handheld wireless devices, such as handheld 
computers, smartphones, and global positioning system (GPS) units. These units can now access 
Internet data and map servers directly so that users in the field can download background data 
layers, collect new data, and transmit them back to the large servers. Cell phone technology is 
advancing rapidly with new geolocation options, web access, and geo-applications arriving daily.

Emphasis on open-source solutions

Instead of relying on proprietary, specialized software, more GIS functions are now implemented 
within open-source software and hardware. GIS data are now more often stored using engines 
from commercial database platforms and use the same development environments as the rest 
of the computer industry. This trend makes it easier to have the GIS communicate with other 
programs and computers and enhances interoperability between systems and parts of systems.

Customization

With emphasis on open-source solutions, new opportunities have developed in creating 
customized applications based on a fundamental set of GIS tools, such as a hydrology tool or 
a wildlife management tool. Smartphone and tablet applications programming is burgeoning. 
These custom applications gather the commonly used functions of GIS into simpler applications, 
introduce new knowledge, and formalize best practices in an easy-to-use interface. Customization 
requires a high level of expertise in object-oriented computer programming. 

Enterprise GIS

Enterprise GIS integrates a server with multiple ways to access the same data, including 
traditional GIS software programs, web browser applications, and wireless mobile devices. 
The goal is to meet the data needs of many different levels of users and to provide access 
to nontraditional users of GIS. The enterprise GIS is the culmination of the other trends and 
capabilities already mentioned. The costs and challenges in developing and maintaining an 
enterprise GIS are significant, but the rewards and cost savings can also be substantial.

What do GIS professionals do?

It’s getting so easy to create a map these days that one may wonder why anyone should bother 
to learn GIS. However, the easy solutions are based on the work of experts who provide the data 



6

Introduction

and the software systems to handle them. It may not be that hard to learn to use a smartphone or 
a web map, but engineers and software developers must build the phones and the infrastructure 
to make them work. GIS is much the same. These days, GIS professionals play a variety of roles.  
A few broad categories can be defined.

Primary data providers create the base data that form the backbone of many GIS installations. 
Surveyors and land-planning professionals contribute precise measurement of boundaries. 
Photogrammetrists develop elevation and other data from aerial photography or the newer laser 
altimetry (LIDAR) systems. Remote sensing professionals extract all kinds of human-made and 
natural information from a variety of satellite and airborne measurement systems. Experts in 
global positioning systems (GPS), which provide base data, are also important.

Applications GIS usually involves professionals trained in other fields, such as geography, 
hydrology, land use planning, business, or utilities, who use GIS as part of their work.  
Specialists in mathematics and statistics develop new ways to analyze and interpret spatial 
data. For these professionals, GIS is an added skill and a tool to make their work more efficient, 
productive, and valuable. 

Development GIS involves skilled software and hardware engineers who build and maintain 
the GIS software itself, as well as the hardware components upon which it relies—not only 
computers and hard drives and plotters but also GPS units, wireless devices, scanners, digitizers, 
and other systems that GIS could not function without. This group also includes an important 
class of GIS developers who create customized applications, including smartphone apps, from the 
basic building blocks of existing GIS software. 

Distributed database GIS involves computer science professionals with a background in 
networking, Internet protocols, or database management systems. These specialists set up and 
maintain the complex server and network systems that allow data services, server GIS, and 
enterprise GIS to operate.

GIS project management

A GIS project may be a small effort spanning a couple of days by a single person, or it can be an 
ongoing concern of a large organization with hundreds of people participating. Large or small, 
however, projects often follow the generalized model shown in Figure I.2, and most new users 
learn GIS through a project approach. A project usually begins with an assessment of needs. What 
specific issues must be studied? What kind of information is needed to support decision-making? 
What functions must the GIS perform? How long will the project last? Who will be using the data? 
What funding is available for start-up and long-term support? 

Without a realistic idea of what the system must accomplish, it is impossible to design it 
efficiently. Users may find that some critical data are absent or that resources have been  
wasted acquiring data that no one ever uses. In a short-term project the needs are generally  
clear-cut. A long-term organizational system will find that its needs evolve over time,  
requiring periodic reassessment. A well-designed system will adapt easily to future  
modification. The creator of a haphazard system may be constantly redoing previous  
work when changes arise.

In studies seeking specific answers to scientific or managerial questions, a methodology, or 
model, must be chosen. Models convert the raw data of the project into useful information using 
a well-defined series of steps and assumptions. Creating a landslide hazards map provides a 
simple example. One might define a model such that if an area has a steep slope and consists of 
a shale rock unit, then it should be rated as hazardous. The raw data layers of geology and slope 
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can be used to create the hazard map. A more complex model might also take into account the 
dip (bedding angle) of the shale units. Models can be very simple, as in this example, or more 
complex with many different inputs and calculations.

Once needs are known and the appropriate models have been designed, data collection can 
begin. GIS data are stored as layers, with each layer representing one type of information, 
such as roads or soil types. The needs dictate which data layers are required and how 
accurate they must be. A source for each data layer must be found. In some cases data can 
be obtained free from other organizations. General base layers, such as elevation, roads, 
streams, political boundaries, and demographics, are freely available from government 
sources (although the accuracy and level of detail are not always what one might wish). 
More specific data must often be developed in-house. For example, a utility company would 
need to develop its own layers showing electric lines and substations—no one else would be 
likely to have it. 

The spatial detail and accuracy of the data must be evaluated to ensure that they can meet the 
needs of the project. For example, an engineering firm creating the site plan for a shopping 
mall could download elevation contours of the site for free. However, standard 10-foot contours 
cannot provide the detailed surface information needed by the engineers. Instead, the firm might 
contract with a surveying firm to measure contours at half-foot intervals.

After the data are assembled, the analysis can begin. During the analysis phase, it is not unusual 
to encounter problems that might require making changes to the model or the data. Thus, the 
steps of model development, data collection, and analysis often become iterative, as experience 
gained is used to refine the process. The final result must be checked carefully against reality to 
identify any shortcomings and to provide guidelines for improving future work.

Finally, no project is complete until the results have been communicated, whether shown 
informally to a supervisor, published in a scientific journal, or presented during a heated public 
meeting. Presentations may include maps, reports, slides, or other media.

Fig. I.2. Generalized flow diagram representing steps in a GIS project
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Web GIS

Since the advent of inexpensive and powerful desktop computers, GIS work has been done 
mainly by using software programs on these computers. The data have usually resided on 
the same computer or on a file server on a local area network. The data were often stored in 
proprietary formats recognized only by the software that created them. However, the urge to 
share information, the expansion of the Internet, the popularity of smartphones and other mobile 
devices, and the desire to spread GIS beyond the scope of a few trained professionals have all 
driven the development of an alternate model, known as Web GIS.

Web GIS comprises a system of components connected by the Internet. It uses the same 
components as a desktop GIS (hardware, software, stored data, etc.), but those components may 
be spread across thousands of miles instead of residing in a single building or single office. 

Many organizations make data GIS available over the Internet. Free data services, such as Google 
Earth and MapQuest, provide access to huge volumes of image and map data. These services 
are tied to specific web applications and mobile apps and cannot be viewed in ArcGIS. Although 
the data quality and documentation procedures are not designed for professional-level work, the 
volume and popularity of these sites introduce many people to GIS techniques and data. Other sites, 
such as the United States Geological Survey’s National Map, do allow users to download data.

GIS servers provide geospatial data over Internet connections. Hosting GIS data on a server 
requires software that responds to requests from users for specific maps or data in the user’s 
current window. Some GIS services are open and free, designed to provide public access to data 
and maps. Others may be locked down to a particular organization or group of users. Many 
organizations use servers to make in-house data available to personnel out in the field or to allow 
employees in different locations to access the same company data sets. Servers provide data in a 
client-neutral format; as long as the client program knows how to use the service, the data can be 
used in ArcGIS Desktop, in a web application, on a tablet, or on a smartphone.

Setting up and managing a GIS server is a complex and expensive task requiring suitable 
equipment, software, and expertise. Cloud-based services are lowering this barrier. A cloud 
consists of warehouses of computers and hard drives managed by a company that rents 
processing power and disk space to clients. Some companies offer space to individuals to  
back up their computers or store movies and music files in a place that is accessible to all  
of their devices. GoogleDrive, DropBox, and Microsoft OneDrive are examples of cloud-based 
data storage that also come with their own applications for group data sharing and collaboration.

Many organizations have moved to the cloud to host their GIS data, either as a complement to or 
even instead of housing their own GIS servers. Advantages of cloud services include the speed 
and ease of deployment, the ability to scale up and down to meet changing demand, and the 
security benefits of hosting public information outside the organizational firewall.

ArcGIS Online 

ArcGIS Online (AGOL) is a cloud-based platform that provides an environment to create and 
share GIS data and tools. It also serves the role of a GIS community. Users can create and join 
groups with common interests. Groups may be open to everyone, such as a group dedicated to 
people who are interested in bicycling and want to share maps about trips and routes. Or they 
may be secure and restricted, allowing a group of researchers to share information privately 
among members invited to be in the group. 

ArcGIS Online is designed around the web map, an interactive map based solely on GIS services. 
Web maps perform a restricted set of basic functions, such as zoom and query; however, they are 
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device independent and can be used in web browsers, 
on mobile devices like smartphones or tablets, and 
even within social media sites. They are simple to 
create and share.

Using servers and web maps to collect data on 
smartphones or tablets has become a widespread 
activity. It is relatively simple to set up a feature service 
and configure it for editing. Users with a free account 
can use ArcGIS mobile applications to access web maps 
and collect data; some students at the South Dakota 
School of Mines and Technology used it to map trees  
on campus and rate damage caused by a blizzard  
(Fig. I.3). Users with a subscription account can use  
the more powerful Collector or Field Map application, 
which is capable of attaching photos and editing while 
out of the range of cell or wireless services. 

The growing capabilities of ArcGIS Online are turning it into an indispensable tool. ArcGIS 
Desktop will remain the primary engine for creating, mapping, and analyzing data because it is 
far more powerful than the web services, but Desktop users certainly benefit from web services.

Types of accounts

Guests can explore featured maps without creating an account in order to learn about the types 
of information available. However, an account is needed to access AGOL’s more advanced 
capabilities. There are two main types of accounts.

A public account gives access to some of the data and some of the functionality, allowing 
users to view data, create map mashups by combining multiple layers of data, save maps, and 
share maps with others. Purchasers of an Esri product are granted an Esri Account, which is 
automatically linked to an ArcGIS Online account. Alternatively, one can request a free public 
account or sign up with an account using a social media login, such as Facebook or Twitter.

Content is categorized as subscriber or premium content. Subscriber content is only open 
to users with an organizational account (as opposed to a public account). Premium content 
requires an organizational account and also consumes service credits, which must be purchased. 

Content in AGOL may be shared with others. By default, content is private and visible only to 
its creator, or it may be shared with a specific group, with everyone in an organization, or with 
everyone in AGOL.

ArcGIS Pro is designed to integrate directly with the capabilities of ArcGIS Online. An AGOL 
account is required to use ArcGIS Pro. On program start-up, you will be asked to supply a user 
account for ArcGIS Online. 

Before starting to learn ArcGIS Pro, it is helpful to get familiar with ArcGIS Online in its web browser 
form. Because it is a live system that is always being improved, it is best to use the online tutorials it 
provides, which are organized as “paths” of linked lessons that lead to a set of skills, such as creating 
maps or sharing data. Here’s how to get started; an account is not required for the first few lessons.

‣‣ Type arcgis.com into a web browser.

‣‣ Select Help from the tab in the browser.

Fig. I.3. Students used smartphones to 
map damaged trees after a blizzard.

Source: Esri
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‣‣ Scroll down and select one of the beginning paths, or click Explore more paths to find 
additional skills.

‣‣ Click one of the lessons, such as “Try ArcGIS Online.”

Learning more about GIS

This book covers many aspects of GIS, but it cannot cover all useful topics. Moreover, the 
industry evolves rapidly. Completing the lessons in the book is only the first step to mastering 
GIS, and smart users constantly seek new information and training to build experience and skill. 
Many methods are available to become more proficient. 

‣‣ Read the Help. Maybe you can figure out a cell phone without the manual, but don’t 
turn away from the wealth of information provided in the ArcGIS Pro Help. It doesn’t just 
have instructions for doing things, but it also includes discussions, diagrams, references, 
and other ways to explore the concepts behind GIS and its implementation.

‣‣ Use the Esri training modules. Esri has dozens of online lessons and seminars avail-
able to registered users. Talk to your GIS instructor about getting access to these courses.

‣‣ Build a GIS library. GIS integrates many disciplines, including geography, surveying, 
cartography, statistics, computer science, spatial statistics, and so on. The more you 
know of these disciplines, the easier it is to understand not just the how of doing things, 
but also the why.

‣‣ Join a professional organization. Many professional societies cater to GIS and remote 
sensing. They have newsletters and journals, conferences, and lots of professionals who 
can help answer questions and share their experiences.

‣‣ Join the Esri Community. Esri hosts an online GIS community that covers many 
aspects of GIS. Members can search for answers to questions or ask questions and get 
answers in a day or two. Groups are available for members with different interests. It is 
a great place to go when you get stuck and have no one else to consult, and it is a good 
place to learn about bugs and workarounds.



11

Chapter 1. What Is GIS?

Objectives

After completing this chapter, you will be able to:

‣‣ Describe how real-world features are represented by GIS data

‣‣ Explain basic differences between the raster and vector data models

‣‣ Define map scale and explain how source scale affects the use of map data

‣‣ Recognize and use both local and Internet sources of GIS data

‣‣ Recognize the types of shortcomings associated with GIS data

‣‣ Correctly cite data sets on a map or in a report

‣‣ Use ArcGIS Pro to explore data and view maps

Mastering the Concepts

GIS Concepts

A geographic information system (GIS) provides data structures and capabilities for storing, 
analyzing, managing, and publishing map data using a computer. Many different software 
packages have been developed to accomplish this task. Although this book focuses on a specific 
software product, many of the concepts are fundamental to all GIS programs, even though the 
details of implementation may differ. In this book, the first section of each chapter, Mastering 

the Concepts, focuses on these cross-cutting fundamental ideas. The second section, About 

ArcGIS, discusses specific details of ArcGIS Pro, a specific GIS software product published by the 
company Esri™ (originally the Environmental Systems Research Institute, Inc., or ESRI).

Representing real-world objects on maps

To work with maps on a computer requires storing different types of map data and the 
information associated with them. Geographic information falls primarily into two categories: 
discrete and continuous. Discrete data are objects in the real world with specific locations or 
boundaries, such as houses, cities, roads, or counties. Continuous data represent quantities 
that may be measured anywhere on the earth, such as temperature or elevation. Many different 
data formats have been invented to encode data for use with GIS programs; however, most 
follow one of two approaches: the vector model, which is designed to store discrete data, or 
the raster model, which is designed to store continuous data. Both models are georeferenced, 
meaning that the information is tied to a specific location on the earth’s surface using spatial 
(x-y) coordinates defined in a standard way. The familiar latitude and longitude values are one 
example; we will learn more about coordinate systems in Chapter 4. Data and software used to 
work with georeferenced information are encompassed by the general term geospatial.

The vector model uses three basic shapes to represent discrete objects, known as features. A 
point feature can represent a single location such as a well or a weather station. Line features 
represent linear objects like roads and rivers. A polygon feature represents a closed area such 
as a county or a state. Vector data sets include two parts: one or more x-y locations that place 
the feature on the earth’s surface (its shape), and a table that stores attributes, or information 
about each feature, such as a state’s name, abbreviation, population, and so on. A set of similar 
features stored together, such as the 50 states comprising the United States, is called a feature 

class. A feature class can store only one type of feature: points or lines or polygons, but never a 
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combination, and the features should be the same type 
of thing. Counties and states, even though both are 
represented by polygons, should be stored in different 
feature classes.

The raster model breaks a geographic area into small 
squares known as cells or pixels, each one containing 
a number representing a value being measured or 
characterized. Some rasters store physical quantities 
like elevation, temperature, or precipitation. Others 
may store color and brightness values that make up 
aerial photographs, satellite images, or a scanned paper 
map. Even discrete features, such as land use or soil 
type polygons, may be represented by rasters if needed, 
even though the model is not optimized for that task.

Figure 1.1 illustrates examples of geospatial data. The 
green triangle is a point feature representing the location 
of a fire lookout tower. The blue line features represent 
streams. The brown shapes are polygons representing 
the preferred habitat areas for a species of snail. The 
background shows a raster composed of 30 m ×  
30 m square cells recording elevation values, with the 
green values representing the lowest elevations and the 
white cells the highest elevations.

Maps are often constructed from multiple data sets. Each data set is typically called a layer 
once it is placed into a map, and the layers are drawn in a hierarchical order defined by the 
cartographer, usually with raster or polygon layers on the bottom and point or line layers on top 
(so that the top layers do not cover up the bottom layers). Figure 1.1 contains four different layers 
from bottom to top: a raster layer of elevation, a polygon layer of snail habitat (brown), a line 
layer portraying streams (blue), and a point layer representing the fire tower (green triangle). 

Map scale

The act of taking a set of GIS features with x-y coordinate values and drawing them on a screen 
or printing them on paper establishes a map scale. On a paper map, the scale is fixed at the time 
of printing. In a digital map configured for interactive display, the scale changes every time the 
viewer zooms in or out. 

What is map scale?

Map scale is a measure of the size at 
which features in a map are represented. 
The scale is expressed as a fraction, or 
ratio, of the size of features represented 
by the map to the size of the actual 
objects on the ground. Because it is 
expressed as a ratio, it is valid for any 
unit of measure. For the common US 
Geological Survey topographic map, 
which has a scale of 1:24,000, one inch 
on the map represents 24,000 inches on 
the ground. The map scale can be used 
to determine the true size of any feature 

Fig. 1.1. Maps may be composed of multiple 
layers of different types of information.

Source: USGS

Fig. 1.2. Solving for the size of a lake for a 1:100,000 
scale map
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on the map, such as the width of a lake (Fig. 1.2). Measure the lake with a ruler and then set up 
a proportion such that the map scale equals the measured width over the actual width (x). Then 
solve for x. Keep in mind that the actual width and the measured width will have the same units, 
which can be converted if necessary.

Often people or publications refer to large-scale maps and small-scale maps. A large-scale map 
is one in which the ratio is large (i.e., the denominator is small). Thus, a 1:24,000 scale map has a 
larger scale than a 1:100,000 scale map. A large-scale map shows a relatively small area, such as a 
city, whereas small-scale maps show bigger areas, such as states or countries.

The type of object used to represent features depends on the scale of the map. A river would be 
represented as a line on a map of the United States because at that scale it is too small for its 
width to encompass any significant area on the map. If one is viewing a USGS topographic map, 
however, the river encompasses an area and is represented as a polygon.

Source scale

When data are stored in a GIS, they technically do not have a scale because only the coordinates 
are stored. They acquire a scale once they are drawn on the screen or on paper. However, a 
geographic data set has a source scale, the original scale or resolution at which it was created 
or converted to digital form. Roads on a 1:24,000 quadrangle map are represented in greater 
detail and with greater accuracy than a highway map for an entire state, such as might be found 
in an atlas. If the roads were converted to a GIS data set by digitizing or scanning, the detail and 
accuracy would be carried forward to the digital format. The source scale of a data set is an 
important attribute and is included when documenting it.

Imagine using data for a project focused on the state of New Jersey. A letter-size page map 
of the state would have a scale of about 1:2,000,000. A map of a county might have a scale of 
about 1:300,000. Examine the three different feature classes in Figure 1.3, which shows the state 
boundary in the Sandy Hook area at a scale of 1:300,000. The purple, orange, and black lines 
represent three different data sets with source scales of 1:25 million, 1:5 million, and 1:50,000, 
respectively. The purple feature class was developed for national-scale maps and is a poor 
representation of New Jersey at this scale. The orange one might be used for statewide mapping, 
and the black one would be suitable for use at the county level. 

One should exercise caution in using data at scales very different 
from the original source scale. A pipeline digitized from a paper 
1:100,000 scale map has an uncertainty of about 170 feet in its 
location, the approximate thickness of the line on the paper. 
Displaying the pipeline on a city map at 1:10,000 might look all 
right, but it could be many feet away from the actual location.

From looking at Figure 1.3, one might conclude that we should 
always obtain and use data at the largest possible scale. However, 
large-scale data require more data points per unit length, 
increasing data storage space and slowing the drawing speed. 
Every application has an optimal scale, and little is gained by 
using information at a larger scale than needed.

GIS data may be assigned a scale range, which specifies the 
range of scales for which the display of the data is valid so that 
it will only be shown at those scales. Many web-based maps use 
scale ranges to present different data sets at different scales, with 
increasing detail as the user zooms further in.

Fig. 1.3. Three New Jersey 
data sets with different 
source scales

Source: Esri 
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Local and Internet data sources

The data used in a GIS can come from diverse sources. For many years, the primary source of 
information was the hard drive of the computer running the GIS software. New data might be 
downloaded from a data clearinghouse or copied from a CD or DVD. If the computer was part 
of a local area network set up by a university or company, it might also have access to shared 
information on a network drive. This capability was especially helpful for large data sets (they were 
stored only once) or shared data that were often updated (so edits did not have to be propagated to 
multiple computers). Local and network drives are still important places to store GIS data.

More recently, the Internet has become a major source for geospatial data. Many organizations 
make data available over the Internet using standard protocols that allow a variety of different 
devices (clients) to access them. Data services such as Google Earth provide access to huge 
volumes of aerial photography and street and transportation information. Often these services 
are not accessed directly by GIS programs but instead are used through web pages, smartphone 
apps, or automotive navigation devices. These services differ from traditional GIS data in that 
users may freely access information as needed, but they cannot download or store the entire 
data sets on the local client. Moreover, the developers of clients that use these resources may be 
charged an access fee to incorporate the services. Creating and updating these giant data sets is 
an expensive and time-consuming business.

GIS servers

GIS servers provide geospatial data over Internet connections specifically for GIS software 
to use. Hosting GIS data on a server requires software that responds to requests from users 
for specific maps or data in the user’s current window. Some GIS servers are open and free, 
designed to provide public access to data and maps. Others may be locked down to a particular 
organization or group of users. Many organizations use servers to make in-house data available 
to personnel out in the field or to allow employees in different locations to access the same 
company data sets. Servers provide data in a client-neutral format; as long as the client program 
knows how to use the service, the data can be used in ArcGIS Desktop, in a web application, on a 
tablet, or on a smartphone.

Setting up and managing a GIS server is a complex and expensive task requiring suitable 
equipment, software, and expertise. Some organizations have moved to the cloud to host GIS 
data, either as a complement to or even instead of housing their own GIS servers. A cloud 
consists of warehouses of computers and hard drives managed by a company that rents 
processing power and disk space to members. Some companies offer space to individuals to 
back up their computers or store movies and music files in a place that is accessible to all of their 
devices; other customers include companies who have found it less expensive or more convenient 
than managing their own servers. Advantages of cloud services include the speed and ease of 
deployment, the ability to scale up and down to meet changing demand, and the security benefits 
of hosting public information outside an organizational security firewall. ArcGIS Online is a 
cloud service commonly used with ArcGIS Pro.

Data quality

Representing real-world objects as points, lines, polygons, or rasters always involves some 
degree of generalization, or simplifying the data for digital storage, such as turning a house into 
a rectangular polygon or even a point. No data file can capture all the spatial or attribute qualities 
of any object. The degree of generalization increases as the map scale decreases. On a standard 
topographic map, a river has a width and can be modeled as a polygon with two separate banks. 
A city would be shown as a polygon area. For a national map, however, the river would simply be 
shown as a line, and a city would be shown as a point. 
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Even a detailed representation of an object is not always a true characterization. Rivers and lakes 
can enlarge in size during spring flooding or shrink during a drought. The boundary of a city 
changes as the city grows. Users of GIS data must never forget that the data they collect and use 
will contain flaws and that the user has an ethical and legal responsibility to ensure that the data 
used for a particular purpose are appropriate for the task. When evaluating the quality of a data 
set, geospatial professionals consider the following aspects.

Geometric accuracy describes how closely the x-y 
values of a data set correspond to the actual locations 
on the earth’s surface. Geometric accuracy is a function 
of the source scale and of how the data were captured. 
Surveying is one of the most accurate ways to position 
features. GPS units have an accuracy that ranges from 
centimeters to tens of meters. Maps derived from aerial 
photography or satellite imagery can vary widely in 
geometric quality based on factors such as the scale of 
the image, the resolution of the image, imperfections 
and distortions in the imaging system, and the types of 
corrections applied to the image. In Figure 1.4, notice 
that the vector road in white is offset in places from the 
road as it appears in the aerial photo. These differences 
can arise from digitizing errors, geometric distortions 
from the camera or satellite, or other factors. 

Moreover, not every feature can be as precisely located 
as a road. Imagine mapping the land-cover types: forest, 
shrubland, grassland, and bare rock in Figure 1.4. 
Where does one draw the line between shrubland and 
grassland? At what point does the shrubland become forest? Six people given this photo would 
create six slightly different maps. Some boundaries would match closely; others would vary as 
each person made a subjective decision about where to place each boundary.

Thematic accuracy refers to the attributes stored in the table. Some types of data are relatively 
straightforward to record, such as the name of a city or the number of lanes in a road. Even in 
this situation, the value of a feature might be incorrectly recorded. Other types of information 
can never be known exactly. Population data, for example, are collected through a process of 
surveying and self-reporting that takes many months. It is impossible to include every person. 
Moreover, people are born and die during the survey process, or they are moving in and out of 
towns. Population data can never be more than an estimate. It is important to understand the 
limitations and potential biases associated with thematic data.

Resolution refers to the sampling interval at which data are acquired. Resolution may be spatial, 
thematic, or temporal. Spatial resolution indicates at what distance interval measurements are 
taken or recorded. What is the size of a single pixel of satellite data? If one is collecting GPS points 
by driving along a road, at what interval is each point collected? Thematic resolution can be 
affected by using categories rather than measured quantities: if one is collecting information on the 
percent crown cover in a forest, is each measurement reported as a continuous value (32%) or as 
a classified range (10–20%, 20–30%)? Temporal resolution indicates how often measurements are 
taken. Census data are collected every 10 years. Temperature data taken at a climate station might 
be recorded every 15 minutes, but it might also be reported as a monthly or yearly average.

Precision refers to either the number of significant digits used to record a measurement or 
the statistical variation of a repeated single measurement. Many people confuse precision with 

Fig. 1.4. Aerial photo near Woodenshoe 
Canyon, Utah

Source: Google Earth and TeleAtlas
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accuracy, but it is important to understand the distinction. Imagine recording someone’s body 
temperature with an oral digital thermometer that records to a thousandth of a degree and 
getting the value of 99.894 degrees Fahrenheit. This measurement would be considered precise. 
However, imagine that the reading is taken immediately after the person drinks a cup of hot 
coffee, which causes the thermometer to measure a value higher than true body temperature. 
Thus, the measurement is precise, but it is not accurate. 

Logical consistency evaluates whether a data model or data 
set accurately represents the real-world relationships between 
features. In the real world, for example, two adjacent states 
share a common boundary that is exactly the same (Fig. 1.5). In 
a database, however, the states might be stored as two separate 
features with slightly different boundaries. Lines representing 
streets should connect if the roads they represent meet. A line 
or a polygon boundary should not cross over itself. A county 
should not extend past the boundary of its state. It takes special 
effort to create and manage feature relationships within and 
between data sets, so not all data sets are logically consistent.

Evaluating the quality of a data set can be difficult, especially 
if the data were created by someone else. Professionals who 
create data usually also provide metadata, which store 
information about the data set, such as where it came from, how it was developed, who assembled 
it, how precise it is, and whether it can be given to another person. The user can use the metadata to 
decide whether a particular data set is suitable for a given purpose. Metadata may consist of a brief 
description of the most critical information, or they may include many pages of detail.

Citing GIS data sources

Ethical and professional considerations require that any map, publication, or report should cite 
the data source(s) used and give proper credit to the originators of the data. The metadata or the 
site from which the data were acquired are good sources of information for citations. The best 
practice is to record the citation when the data are obtained so the information is available when 
needed. Generally one cites only data that are publically available (free or purchased). Data 
created internally within the workplace need not be cited, although often the company name or 
logo will appear on the map. A data set provided once in response to a personal request should 
be cited as a personal communication. On a map, only one citation need be included for multiple 
data sets from the same source, but a report should list all data sets from each source.

Keep in mind that the place where data are found may not be their original source. A GIS 
administrator may have placed often-used data sets, such as Esri™ Data and Maps, on a 
university file server for easy access, but the fact that they were obtained internally does not free 
students from the need to cite them, and the original source should be cited, not the local server.

General format

The purpose of a citation is to allow other people to find and obtain the data. It is not always 
possible to find all the information needed for a complete citation, but one should do one’s best to 
make it as complete as possible. The following general format for citations may be used:

Data set name (Year published) [source type]. Producer name, producer contact information. 

Data set name. The name is assigned by the creator or provider of the data.

Fig. 1.5. A coincident boundary 
gets stored twice but is the 
same for both features.

Source: Esri 
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Year published. Some data sets are assembled and provided once or at long intervals, and these are 
considered to have a publication date. For example, before ArcGIS Online, the Esri™ Data and Maps 
product was released in revised form with each version of the software and carried a publication year. 
Aerial photography is flown on a particular date (although mosaics such as Google Earth use multiple 
sources spread over several years). It may take a little hunting to find the publication date. Some data 
sets are updated at shorter intervals or are even live. These can be assigned the current year in which 
they were accessed.

Source type. Indicate the format in which the data are available. Types might include physical 
media (DVD, CD-ROM), a file downloaded from the Internet, or a service that provides live data 
on demand. Different types of services exist, and new types are being added all the time.

Producer name. Give the name of the person or agency that makes the data available. In some 
cases, this source may be different from the originator of the data. For example, Esri publishes 
Data and Maps using data from many different sources. ArcGIS Online serves public data.

Producer contact information. For a company or small agency, the city and state should be 
included. For large agencies, particularly those with many offices but a unified web presence, the 
name itself is sufficient. Indicate a clearinghouse name, such as ArcGIS Online, if appropriate.

Resource URL. This entry is optional; include when appropriate. Use only static URLs, even if 
it means the user has to hunt for the data. (A static URL always has the same form, whereas a 
dynamic URL is generated automatically based on search strings or other information. Dynamic 
URLs generally include query control characters such as ? or %.)

Date accessed. This entry is optional because it mainly applies to online data sets. Include the 
year and month when you accessed or downloaded the data.

Examples of citations

Black Hills RIS Vegetation Database (2008) [downloaded file]. Black Hills National Forest, Custer, 
SD. URL: http://www.fs.usda.gov/main/blackhills/landmanagement/gis [August, 2010].

Esri™ Data and Maps (2012) [DVD]. Esri™, Inc., Redlands, CA. 

National Hydrography Dataset (2015) [downloaded file]. United States Geological Survey on the 
National Map Viewer. URL: http://viewer.nationalmap.gov/viewer/ [July 23, 2015].

USA Topo Maps (2009) [map service]. Esri™ on ArcGIS Online. URL: http://server.arcgisonline 
.com/arcgis/services/USA_Topo_Maps/MapServer [January 1, 2012].

EIA Coalbed Methane Field Boundaries (2011) [map service]. US Department of Energy on Arc-
GIS Online. URL: http://arcgis.com [August, 2013].

Mineral Operations of Africa and the Middle East (2010) [layer package]. J.M. Eros and Luissette 
Candelario-Quintana on ArcGIS Online. URL: http://ArcGIS.com [July, 2012].

Badlands National Park GIS Database (2012) [CD-ROM]. Interior, South Dakota: National Park 
Service—Badlands National Park, personal communication. 

Airports (2018) [file geodatabase feature class] Price, M.H, Mastering ArcGIS Pro First Edition 
(tutorial data) mgisdata\Oregon\oregondata.gdb\airports, [01/04/2018]

About ArcGIS

ArcGIS overview

ArcGIS is developed and sold by Esri™. It has a long history and has been through many versions. 
Originally developed for large mainframe computers, it has metamorphosed from a system based 
on typed commands to a graphical user interface (GUI). Data models, too, have changed over time, 
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with an increased emphasis on accessing data through the Internet. The following background 
information should help you to understand the nature of the ArcGIS system and its data.

The old core of the ArcGIS system was initially released in 1982. Called Arc/Info, it included three main 
programs: Arc, ArcEdit, and ArcPlot (Fig. 1.6), which were built to run on mainframe computers or Unix-
type workstations. All of the programs were command based, meaning that the user typed commands 
to make the program work. The difficulty of learning Arc/Info prompted Esri™ to create ArcView 3 in 
1992, a GUI-based program that was easier to use but not as powerful as Arc/Info. 

ArcGIS Desktop, released in 2001, combined the power of Arc/Info and the ease of ArcView, and it 
was ported to the Windows operating system so it could be used on a PC instead of an expensive 
workstation (earning the name desktop GIS). It contained two programs: ArcMap, which could 
display, analyze, and edit spatial data, and ArcCatalog, which managed the spatial data files. 
ArcToolbox contained task-based programs, or tools, that could be used in either program. 

Arc/Info, ArcView, and ArcGIS Desktop were originally designed to use GIS data files residing 
on a local or networked hard drive. However, as Internet-based services expanded, Esri™ began 
to develop ways to serve GIS data over the World Wide Web. ArcGIS Portal (following its earlier 
incarnations as ArcIMS [Internet Map Server] and ArcGIS for Server) was built to enable sharing 
of GIS data. These systems store geospatial data within a commercial database, such as Oracle 
or SQL Server, and they interact with the World Wide Web to provide data to different clients, 
including desktop GIS, mobile phones, and web browser applications. These systems can provide 
both GIS data and GIS analysis tools.

ArcGIS Pro (often shortened to Pro in this text) is the latest version of the desktop GIS. It was 
designed to take full advantage of multicore 64-bit processors and to easily use GIS services. It has 
a new interface design and a new system for organizing work. Early versions did not incorporate 
all of the functionality provided by ArcMap and ArcCatalog, but new capabilities are added with 
each version.

Fig. 1.6. The original Arc/Info program evolved through ArcView and ArcGIS Desktop to 
ArcGIS Pro, as web GIS servers evolved from ArcIMS and ArcGIS for Server to ArcGIS Portal.



What Is GIS?

19

Both ArcGIS Desktop and ArcGIS Pro provide different levels of functionality (Basic, Standard, 
and Advanced) so that users can save money by buying only the level they need. This book 
primarily uses the functions available in ArcGIS Basic. The platform may be expanded by 
purchasing extensions, or additional software capabilities designed for specific applications 
such as analyzing raster data (the Spatial Analyst extension) or doing advanced spatial statistics 
(the Geostatistical Analyst extension). By default, the extensions are installed with the main 
program but require an additional license in order to be used.

ArcGIS Online (AGOL) is a cloud-based platform that provides many GIS data services as well as 
an environment to create and share maps and data with other users. AGOL is structured around 
the web map, a map that uses only GIS services. These web maps can be consumed by a variety 
of clients, including ArcMap, ArcGIS Pro, web pages, smartphones, and tablets. 

ArcGIS Pro is designed to integrate directly with the capabilities of ArcGIS Online. The first time 
the program is started, the user is asked to supply an AGOL user account, which will usually be 
provided by the course instructor. An account may be a free public account or a subscription 
account, which provides access to more data and features than a public account. A few of the 
exercises in this book require a subscription account.

TIP: If you don’t have access to a subscription account through your instructor, Esri™ offers a 
temporary trial that includes ArcGIS Online and ArcGIS Pro.

The project

Work in ArcGIS Pro is structured within an entity called a project, which organizes many types 
of information needed to do GIS work. Projects are usually developed for a particular geographic 
area or to accomplish a set of tasks associated with a work project (hence the name). Projects 
may contain many types of items. Figure 1.7 shows the ArcGIS Pro interface, currently displaying 
the contents of a project named PacificNorthwestHazards. The center program area portrays 
views, or different objects that the user might work with, such as maps or tables. A Contents 

pane on the left shows different map layers, such as the volcanoes and capitals; the Catalog pane 
on the right organizes the different items available within the project; they are discussed next in 
the order in which they appear in Figure 1.7.

Map. Maps are views that display GIS data sets together using specified symbols, labels, and 
so on. A map may be two dimensional (Hazards in Fig. 1.7), or it may be visualized in three 
dimensions, in which case it is called a scene.

Toolbox. ArcGIS Pro includes many distinct program routines (tools) used to accomplish specific 
tasks. A user can also create custom tools (models) or write programs (scripts) in a language 
called Python. Tools created for a specific project can be saved within the project for easy access.

Database. Databases that contain geographic data are often called geodatabases. Every project 
starts with a home geodatabase, a place to store GIS data associated with and generated by 
work on the project. The geodatabase adopts the name of the project (PacificNorthwestHazards) 
and is the default location where output data sets are saved.

Geoprocessing history. The project keeps track of every tool run so that one can review 
previous steps or check what settings were used to run a tool.

Layout. Layouts are formal page designs for printing maps, either on paper or to an electronic 
format such as PDF. Layouts can portray one or more maps and contain titles, legends, scale 
bars, north arrows, and so on.
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Style. Styles are collections of symbols used to portray map data. ArcGIS Pro comes with default 
styles (2D and 3D) containing symbols that may be customized individually to meet a specific 
need. In addition, users or organizations can develop and share their own styles; for example, a 
set of symbols used to publish geologic maps.

Folder. By default, the project file (e.g. PacificNorthwestHazards.aprx) is created inside a folder 
with the same name as the project, known as the project folder. The home geodatabase also 
resides here. The project folder can be used to store non-GIS data associated with the project, 
such as word processing documents or spreadsheets. (If the project contains a great deal of 
additional data, subfolders can be created within the project folder to organize it.) Although some 
of the data used in a project will be stored in the home geodatabase, it is common to use external 
data as well, such as information stored elsewhere on the computer or on an organization’s file 
server. A project stores folder connections that remember the locations of these data sources 
for quick access. 

Locator. Locators are used to convert street addresses into points on a map by comparing them 
to data about streets and their address ranges. ArcGIS Online has a default locator, the World 

Fig. 1.7. The ArcGIS Pro program interface

Source: Esri
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Geocoding Service, which it uses to find a location from a single typed address. Users can create 
custom locators if they possess the right kind of street data.

Task. Tasks are step-by-step instructions set up to record a certain workflow for future reference 
or to share with others to make sure that a procedure is correctly performed each time. One can 
record a series of steps as they are performed and then explain them with detailed instructions.

Portal. Portals provide access to GIS services available over the Internet. Several types of 
portals are included: (1) data and services hosted in your ArcGIS Online account; (2) public 
services hosted by others in AGOL; and (3) any other services hosted by organizations to which 
you belong and have access (a login and password may be required).

The ArcGIS Pro interface

ArcGIS Pro is a powerful program that does many things, so fitting all the tools and 
commands into a single window on a computer is a daunting task. You must understand the 
design of the GUI to work effectively with the program and to follow the instructions in this 
book’s tutorials.

Pro uses a ribbon-style interface to present access to the functions and commands (Fig. 1.8). It 
includes core ribbons, which are always visible, and contextual ribbons, which only appear as 
you select and work with different parts of the project. For example, when a map layer is clicked, 
the Feature Layer collection of ribbons appears (Appearance, Labeling, and Data) and can be 
used to modify how a layer looks and behaves (Fig. 1.8). 

Within each ribbon, buttons are organized into functional groups. In Figure 1.8, the Map ribbon 
is currently active and shows five groups, including Clipboard, Navigate, Layer, and Selection. 
Some buttons have a small black arrow underneath (drop-down buttons, like Basemap), which 
indicates that more than one command is accessible from that button. Simply clicking a drop-
down button will access the command currently shown; use the black arrow to select a different 
button. Some groups have a small boxed arrow in the lower-right corner, the Group options 
button. This button will open properties related to that group so the settings can be modified.

Clicking buttons results in many different actions. Some buttons turn the cursor into a specific tool; 
others may execute an action (such as zooming in), and some open additional menus, windows, or tools.

There are two basic skills to master in navigating the Pro interface. The first is to learn the 
terminology for the many program objects (windows, views, and panes) and to learn to 

Fig. 1.8. Ribbon organization and terminology

Source: Esri
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manage those objects efficiently. The second 
skill is to get used to the way the interface 
changes as one works.

Below the ribbon is the main program window. 
A window is a work area that can contain two 
types of objects, views or panes. Windows may 
be floating so that they sit on top of the program 
area, but more commonly they remain docked 
within the program area. 

A view is a window that contains an entity to 
work with, such as a map, a 3D scene, a table, or 
a chart. Views can be docked only in the center 
window of the program, as in Figure 1.7. Multiple 
views may be open at once, although only one of 
them can be active at a time. 

A pane contains commands or settings used to 
work with the active view (Fig. 1.9). Panes may 
have multiple tabs used to organize the settings 
into related sections, icons that present different 
panels containing options or settings, headings 
that organize settings within a tab, or an Options 
menu that accesses additional commands or 
settings. Panes are placed in windows that may 
be docked around the edges of the program 
area. Many panes can be open at the same time; 
they may be placed side by side or stacked on 
top of each other in a window. In Figure 1.7, the right-hand window docked on the side of the 
program area contains two panes, an active pane (the Catalog pane) and the Geoprocessing pane 
underneath it (visible as a tab at the bottom of the window).

A single window may contain multiple views or panes (but not both). Within the window, the views 
or panes may be stacked atop each other, in which case the top one is active. The user switches to a 
different one by clicking a tab along the top or bottom of the window. Windows also have an auto-
hide function, which turns a window into a tab at the edge of the program, keeping it out of the way 
until it is needed. Clicking the tab opens the window, and moving or clicking elsewhere closes it. 

The key to the second task is to understand that the GUI is context sensitive; it changes as 
you work. Ribbons and buttons only show when it is appropriate to use them, which means 
that selecting a particular type of object is sometimes required to make the ribbon or buttons 
visible. For example, a map layer must be selected to change how it looks. Although this flexible 
arrangement is initially confusing, one soon learns how to make particular menus appear. To 
make it easier, some objects have a context menu that opens when right-clicked to choose a 
function directly. Hence, there are often multiple pathways to the same function. 

Users soon develop their own preferences for managing the interface. Some people like an 
uncluttered view and will open and close windows each time. Others like to have certain windows 
docked and ready at all times, and they develop elaborate grouping schemes to keep certain 
panes accessible. Sometimes it depends on the workflow: if one is working on symbolizing many 
map layers, it is handy to keep the Symbology pane open throughout and then close it when 
ready to analyze data. When editing, it is convenient to group several editing panes in the same 
window and switch back and forth between them.

Fig. 1.9. Pane organization and terminology

Source: Esri
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TIP: Because the program interface is so flexible, describ-
ing how to navigate it in a tutorial is challenging. Learn the 
meanings and distinctions between the terms window, view, 
pane, and tab to better understand the instructions.

Tools and geoprocessing

Many operations in ArcGIS Pro are performed using tools. A 
tool is piece of software designed to perform a specific task, 
such as deleting a file or calculating statistics. Achieving 
one’s objective may involve executing several tools in 
sequence; which is called geoprocessing. Tools may be 
accessed several ways: by clicking a button on a ribbon, 
by choosing an item from a menu, or by selecting a tool in 
the Geoprocessing pane (Fig. 1.10). Tools are organized 
functionally into toolboxes (some of them are shown in  
Fig. 1.10). Examining the contents of the toolboxes is a good 
way to investigate the many capabilities of ArcGIS, although 
searching is usually a quicker way to find a specific tool.

After opening a tool, the user must set 
parameters that instruct the tool how 
to proceed. Parameters are different for 
each tool. Figure 1.11 shows the Buffer 
tool, which creates polygons showing 
areas within a certain distance of a set 
of features. The parameters include 
the input features (Roads), a name and 
location for the output polygon dataset 
(roadbuf300), plus various settings that 
modify the size and shape of the buffers.

Some common options apply to all 
tools (shown by numbered squares in 
Fig. 1.11). (1) The back button clears 
the settings and returns to the main 
Geoprocessing pane. (2) The Options 
button opens a menu with additional 
choices. (3) The Help button opens a 
detailed description of the tool. (4) The 
Environments tab opens additional 
settings that can be applied to the tool. 
(5) The information icon appears when 
the cursor is near a parameter box; it 
gives information about the parameter. 
(6) A warning icon appears to notify the 
user of a potential issue, perhaps that 
the designated output file already exists 
and will be overwritten. (7) An error 
icon appears to indicate that an error 
is present and the tool will not run until 
it is corrected. Both warning types will 

Fig. 1.10. Some of the toolboxes 
in the Geoprocessing pane

Source: Esri

Fig. 1.11. Running a tool

Source: Esri
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show a pop-up explaining the issue if the cursor is placed on top of the warning icon. (8) The Run 
button executes the tool.

TIP: When using a tool for the first time, always read the detailed help information and examine 
the pop-up information boxes for each parameter. These resources describe the tool and may 
contain critical information for making it work properly.

ArcGIS Pro includes several ways to automate tools and tasks to make geoprocessing tasks 
repeatable and more efficient. These techniques will be covered in Chapter 12.

Summary

‣‣ A GIS is a spatially enabled database that uses map and attribute data to answer questions 
about where things are and how they are related. 

‣‣ Maps may represent discrete features, such as a road or a lake, or continuous measurements, 
such as elevation or temperature. The vector data model is ideal for discrete data, and the raster 
data model excels at storing continuous data.

‣‣ Map scale is the ratio of the size of objects in the map to their size on the ground. The source scale 
of GIS data affects their accuracy and precision and the map scales for which they are suitable.

‣‣ GIS data may be stored locally on a hard drive or on a network server, but data may also be 
accessed through Internet connections via GIS servers. Server data can be accessed by many 
clients, including GIS programs, web pages, smartphones, and tablets.

‣‣ Every GIS user has a responsibility to ensure that data are suitable for the proposed  
application and an obligation to cite the sources of data used.

‣‣ Data quality is measured in terms of geometric accuracy, thematic accuracy, resolution, and 
precision. Metadata store information about GIS data layers to help people use them properly.

‣‣ ArcGIS Pro uses a flexible and context-sensitive GUI. Understanding the names of interface 
objects (ribbon, window, view, pane, tab, and heading) helps to navigate the lessons.

Important Terms

ArcGIS Online folder connection map scale resolution

attributes generalization metadata scale range

cell geometric accuracy pane scene

client geoprocessing panel source scale

cloud geoprocessing history parameter style

Contents pane georeferenced pixel table

contextual ribbon geospatial point task

continuous home geodatabase polygon thematic accuracy

core ribbon layer portal tool

database layout precision Toolbox

discrete line project vector

extension locator project file view

feature 
feature class

logical consistency
map

project folder
raster

web map
window
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Chapter Review Questions

1.	 Explain the difference between discrete and continuous data sets in your own words.  
Give three examples of each.

2.	 A 50-m long swimming pool measures 2-cm on a large scale map. What is the scale of the map?

3.	 Explain why GIS data sets are considered to have a source scale but not a map scale.

4.	 In what ways have the sources from which GIS data are obtained changed?

5.	 Jamie is hiking trails in a forest and using his smartphone to track his position. In this remote 
location with heavy tree cover, his phone typically records his position within 25 to 50 meters. 
Discuss the accuracy and precision of the trail map he creates.

6.	 Judy creates a smartphone app that allows bird-watchers to upload the location and species 
of birds that they spot. Discuss the potential data quality issues that might affect her final 
map of bird sightings.

7.	 Construct an appropriate citation for the data that come with this book.

8.	 Compare and contrast the terms window, view, and pane as they relate to the ArcGIS Pro 
user interface.

9.	 Explain what geoprocessing tools and parameters are.

10.	 Describe the difference between core ribbons and contextual ribbons.

Expanding your knowledge

Open the ArcGIS Pro Help main page and follow the links to these topics. Explore these sections 
to learn more about working with aspects of Pro introduced in each chapter. (The organization 
and content of the Help may change over time. If the specified sections are no longer available, 
look for similar ones.)

Help > Projects > Catalog pane, catalog view, and browse dialog box

Help > Projects > Terminology for working with projects

Help > Project > Project items

Help > Maps and scenes > Interact with maps and scenes

Mastering the Skills

Preparing to begin

The tutorials in this book use a data set available for download from the book web site at http://
www.mhhe.com/Price_pro2e. These data must be installed before starting the tutorials. Each step 
of the tutorials and all skills learned in this book are illustrated by video clips. See the web site 
for instructions on downloading and using the tutorial data and videos.

A TIP gives useful information about the program or settings that will save time or that are im-
portant to know. Pay attention to them.
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TIP: In these tutorials, values you must enter are shown in this font: type this. 

Teaching Tutorial 

The following examples provide step-by-step instructions for doing tasks and solving problems 
in ArcGIS Pro. The steps to do are highlighted with an arrow →; follow them carefully.

TIP: This book comes with a folder of data called gisclass. Install it on the C:\ drive of the 
computer and not in your Documents folder, Desktop, or a network drive. Once installed, 
remember where it is to access it when needed.

Exploring an ArcGIS Pro project

ArcGIS Pro (or Pro, for short) organizes geospatial work in a project, a container that 
remembers the data, maps, and tools being used and organizes them into one folder.

1→ Start ArcGIS Pro and log in with an ArcGIS Online subscription account. 

1→ Choose the Open another project link. Click Computer to access the computer files.

1→ �Navigate to the C: drive and then to the gisclass folder (wherever you placed it). It 
contains two folders, a ClassProjects folder for storing projects related to this book 
and the mgisdata folder containing additional GIS data.

1→ �Navigate into the ClassProjects folder and then into the CraterLake project folder.

1→ Click the project file, CraterLake.aprx, to highlight it. Click OK.

TIP: The four-letter .aprx code is called an extension. Whether it is shown depends on the  
Windows folder settings. If you don’t see it, ignore it and other extensions for the time being.

The center of the program window is occupied by a map view of Crater Lake, Oregon. The name 
of the map, Crater Lake, appears in the upper-left corner on a view tab. To its left, the Contents 
pane shows the map name at the top and the different layers that make up the map (rock types, 
faults, volcanic vents, etc.). 

2→ �Click the Lake check box to turn off the Lake layer. The rock units of the floor of  
the caldera are revealed.

2→ �Below the Lake layer, examine the Crater 

Lake Geology entry, known as a group layer. 
Uncheck the box next to it to turn all layers 
in the group off.

2→ �Turn on the Hillshade layer, a raster that 
shows the terrain. 

2→ �Turn on the Crater Lake Geology group 
layer again. The Rock Types layer is slightly 
transparent so that the terrain beneath it can 
be seen.

2→ �Turn the Lake layer back on.

The Contents pane has several icons that open panels with different functions (Fig. 1.12).

TIP: Menus and panes may change slightly depending on your software version, and they are also 
customizable, so they can appear slightly different in the figures from what you see on your screen.

Fig. 1.12. Icons that open panels of 
the Contents pane

Source: Esri
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3→ �In the Contents pane, hover over the first icon until its name appears, List By Draw-
ing Order. This is the default view of the pane. 

3→ �Click on the List By Data Source icon (the second one), which shows the source of 
the data used in the map, which shows the source of the data used in the map (the 
location of the data file). Most of the data comes from the gisclass folder, but the 
Topographic layer is an Internet-based GIS service.

3→ �Click through each of the remaining icons to examine the different panels.

4→ �When finished, return to the List By Drawing Order panel (the first one), which can 
change the order of drawing layers. Layers are drawn in order from bottom to top.

4→ �Click and drag the Lake layer above the Vents layer. Notice that the vents in the lake 
disappear because they are covered by the lake polygon when drawn in this order.

4→ �Move the Lake layer back between the Faults and Crater Lake Geology layers.

The top of the window organizes the program functions using ribbons titled Project, Map, Insert, 
and so on. Each ribbon has different buttons and settings, organized into functional groups.

5→ �Click the Map ribbon tab and examine its groups: Clipboard, Navigate, Layer, and 
so on.

5→ �Click each of the main ribbon tabs in turn and examine the groups and buttons.

The ribbon menu is context-sensitive: different ribbons may be visible depending on what is 
selected in a pane or view. Certain buttons may be accessible or unavailable (dim) based on what 
the user is doing.

6→ �In the Contents pane, click to highlight the Crater Lake map title. Examine the 
ribbon titles.

6→ �In the Contents pane, click on the Vents layer name to highlight it. Notice that a new 
ribbon group appears, Feature Layer, with three additional ribbons: Appearance, 
Labeling, and Data.

6→ �Click on each of the three Feature Layer sub-ribbons and examine the groups and 
buttons.

The Feature Layer ribbons are used to control the behavior of a layer: how it appears, whether 
it has labels, and so on. These buttons only make sense when applied to a particular layer, which 
is why a layer must be selected to make them visible.

TIP: If a particular ribbon is not visible, check to make sure that the appropriate item is high-
lighted to make the ribbon appear.

TIP: The tutorial instructions refer to ribbon functions using the format Ribbon Name:  

Sub-ribbon Name: Group: Button > Drop-down button options. The Sub-ribbon Name  
and Drop-down portions may not always be present.

7→ �In the Contents pane, click the Lake layer to highlight it.

7→ �Click the Feature Layer: Appearance ribbon and find the Effects group. Set the 
Transparency to about 50%, revealing the rock units underneath. 

7→ �Click the Rock Types layer and click Swipe in the Effects group. Place the cursor on 
an edge of the map; then click and drag toward the center to reveal the Hillshade layer. 

7→ �Click on the Effects: Swipe tool again, but notice that it does not turn off. 
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Some buttons stay in effect until another button function is 
selected, such as choosing the Explore button to navigate 
the map.

Navigating 2D and 3D maps

8→ �Click the Map ribbon title and examine the 
Navigate group (Fig. 1.13).

8→ �Notice that the Swipe tool is still enabled 
even after switching ribbons.

8→ �Hover over the Explore button. A button tip appears, explaining how to use the 
mouse to navigate the map. All buttons have pop-up explanations. 

8→ �Click the Explore button and place the cursor over the map. The Swipe triangle is 
replaced by a hand icon for panning the map.

8→ �Use the Explore button instructions to learn how to pan and zoom. 

8→ �Hold the mouse over the other buttons in the Navigation group to read about what 
they do. Experiment and practice with them to understand how each works.

Some button groups have an options menu that accesses additional settings related to that group.

9→ �Hover over the small box/arrow icon on the lower-right corner of the Navigate 
group, until it shows the pop-up text Navigation Options. 

9→ �Click the Navigation Options icon. The Options window opens.

The left side of the Options window lists groups of settings; the Navigation options are already 
selected. Click on the other sections to explore them, but then return to the Navigation section.

9→ �Rolling the mouse wheel forward may be assigned to Zoom in or Zoom out,  
depending on the user preference. Change the setting now if desired.

9→ �Click OK to accept the change. 

10→ �Click on one of the geologic units in the map (not in the lake). The polygon flashes 
and a pop-up window appears with information about the polygon.

10→ �Click on one of the geologic units in the lake. The pop-up shows information about 
the lake instead because it is the top layer.

10→ �Click the little black arrow near the bottom of the Explore button and examine 
the menu choices. They control which layer(s) will appear in the pop-up.

10→ �Select the Explore button option: Selected in Contents.

10→ �In the Contents pane, click on the Crater Floor Geology layer to select it and then 
click one of the geologic units in the lake in the map. Now the pop-up shows the 
crater floor geology. 

10→ �Close the pop-up when finished.

11→ Click the Full Extent button to go to the extent of all the layers in the map. 

Unfortunately, the Topographic basemap layer has a very large extent (map area). The default 
Full Extent can be changed using the map’s properties.

11→ �In the Contents pane, right-click the icon by the Crater Lake map title and choose 
Properties.

Fig. 1.13. Navigation tools

Source: Esri
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11→ �On the left side, click on 
Extent to see those properties 
(Fig. 1.14).

11→ �Click Use a custom extent. 
Under Get extent from, click 
the Crater Lake Geology  
layer. Click OK.

11→ �Click the Full Extent button 
again and it will zoom to  
Crater Lake.

Bookmarks are another way to store a 
particular map extent and easily return to it. 
One bookmark has already been created for 
this project.

12→ �Click Map: Navigate: Bookmarks > Crater Lake.

12→ �Zoom in to the island on the west side of the lake.

12→ �Choose Bookmarks > New Bookmark. Enter the name Wizard Island. Click OK.

12→ �Click the Bookmarks drop-down and select the Crater Lake bookmark to return to 
the view of the lake.

The final navigation tool, Zoom to Selection, is dim because something must be selected before 
one can zoom to it.

13→ Click Map: Selection: Select (just the button, not the drop-down triangle).

13→ �Click on Wizard Island. The polygon clicked is highlighted in blue, indicating that it 
is selected.

13→ Click the Zoom to Selection button in the Navigate group . 

13→ Zoom to the previous extent.

Multiple features may be selected by drawing a box around them.

14→ �Click the Select button in the Selection group. Click and drag a box around several  
geologic units. Features that pass partially inside the box will be selected.

14→ Click the Clear button in the Selection group to clear the selection. 

15→ Choose Map: Inquiry: Measure > Measure Distance.

15→ �Click on the map to enter a line across the lake and double-click to end the line. 
Read the distance.

15→ Change the units from Metric to Miles using the drop-down box.

15→ �Explore this tool and the other tools in the Measure drop-down until you can  
measure distances, areas, and features in a variety of units. 

15→ �When you are finished, close the Measure tool.

1.	 What is the area of the lake in hectares? _____________________

Fig. 1.14. Setting the full extent area

Source: Esri
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16→ �Click the Map: Inquiry: Locate tool. It opens the Locate pane.

16→ �Type Timber Crater in the search box and select Timber Crater, Oregon, USA 
from the list that appears. The map zooms to Timber Crater.

16→ Search for Olympia and zoom to Olympia, WA, USA. 

16→ �Close the Locate pane and click the Full Extent button to return to Crater 
Lake.

Some new symbols probably appeared as you 
zoomed to Wizard Island.

17→ �Click the Explore button and zoom in 
to the rock units southwest of the lake 
until some different symbols appear. 
Zoom in more until the labels appear 
(Fig. 1.15).

17→ �Examine the Contents pane and find 
the Classes and Labels layer. Expand 
it (by clicking the triangle next to it) to 
see the volcanic class symbols.

17→ �Zoom out until the volcanic class sym-
bols disappear from the map. Notice 
that the check box by the layer turns 
light gray, indicating it is inactive and 
cannot be changed.

In this map, the Class and Labels layer has been 
given a scale range because the symbols would 
clutter the map if viewed at smaller scales. Layers 
can be given many properties to control how they 
appear and behave.

17→ �In Contents, click the Classes and Labels layer to highlight it and reveal the  
Feature Layer ribbon group. Click the Appearance ribbon title.

17→ �In the Visibility Range group, notice that the Out Beyond scale has been set to 
1:24,000. These symbols appear when the map is zoomed in below that scale.

17→ �Click the Feature Layer: Labeling ribbon and examine the Visibility Range 
group. A similar setting has been applied to the labels at 1:10,000.

Using the Help

Pro can do much more than can be covered in one textbook. The Help provides an extensive 
resource for learning more about the software and its capabilities. Getting familiar with the Help, 
and exploring it often, will greatly enhance your knowledge and skills. The Help is accessed 
online by default, although it can be downloaded and saved locally.

18→ �Click the Project ribbon and select the Help entry. Wait a moment while a web 
browser opens to the main Help page. If you are asked to log in, use the same 
account as for ArcGIS Pro.

18→ �Examine the solid bar containing the “ArcGIS Pro” heading and the tabs underneath 
it: Home, Get Started, Help, and so on (Fig. 1.16). Notice that the Help tab is  
currently active.

18→ �Examine the outline of topics on the left: Projects, Maps and scenes, Data, . . . Each 
heading can be expanded or collapsed for more information.

Fig. 1.15. The volcanic unit types and 
labels don’t appear until a preset scale is 
reached.

Source: USGS
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18→ �Examine the content presented on the right side of the window.

18→ Expand the Projects heading, and examine the entries.

18→ Click on the Terminology for working with projects entry.

18→ Skim through the topics presented in the content for this section.

TIP: The Help organization and content may change over time as the software is updated. If a 
specific item referenced in this text cannot be found, try looking for a similar topic.

19→ In the outline on the left, click the Project items heading.

19→ �Notice the expansion of the outline and the many blue links to additional informa-
tion within the content.

19→ Click on one of the blue links in the content.

19→ �Scroll to the bottom of the content and notice additional links in the Related topics 
section.

It is easy to get lost within this information. Use the breadcrumb trail immediately below the title 
bar (1 in Fig. 1.16) to back up to the main sections.

19→ Click Projects in the Help > Projects … breadcrumb trail.

19→ Click Help in the breadcrumb trail to return to the main Help page.

The SEARCH function provides another method to find information.

20→ �Click the Search icon. Be sure to use the Help search tool (2 in Fig. 1.16) and not 
the search box of the browser, which would leave the Help.

20→ �Type symbols on the Search line and click Search.

The left outline now presents filters for different software packages and versions, currently set 
to ArcGIS Pro. The right side contains different articles. Notice that each article has “ArcGIS Pro” 
listed after the title. Be sure to view only Pro content for any article.

20→ Click on one of the articles, such as Modify symbols.

20→ Briefly examine the outline and the content.

20→ Examine the breadcrumb trail to learn which section of Help is being shown.

20→ �Click on each entry in the breadcrumb trail, starting with the last, to back out of 
the content and return step-by-step to the main Help page.

Fig. 1.16. The top of the Help window

Source: Esri
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TIP: In the Search Results page, the main outline and Help tabs disappear. Select an article to get 
them back, or click ArcGIS Pro at the top of the window (3 in Figure 1.16) and click the Help tab.

20→ �Minimize the browser window with the Help, rather than closing it, to facilitate con-
sulting it later.

20→ Return to the ArcGIS Pro program.

Managing windows

Projects can contain more than a single map. The Catalog pane is used to access and manage the 
different items in a project.

21→ �Examine the Catalog pane to the right 
of the map (Fig. 1.17). Notice that 
the window has several tabs: Project, 
Portal, and Favorites. (If the Catalog  
pane is not visible, click View: 

Windows: Catalog Pane to show it.)

21→ �The Project tab should currently be  
selected; click it if not. It will show 
a list of project resources, including 
Maps and Toolboxes.

21→ �Click the triangle next to Maps to ex-
pand the section. It contains the Crater 

Lake map (already open), plus three 
3D maps (known as scenes).

21→ �Double-click the Crater Lake_3D scene 
to open it. 

Notice that the previous Crater Lake map view 
remains open and is visible as a view tab (above 
the scene), making it easy to switch back and forth. 
Clicking the x on the tab closes the map, but it 
remains in the project and can be reopened from the 
Catalog pane.

22→ �Use Map: Navigate: Bookmarks to create a new bookmark named Crater Lake 3D.

22→ �Hover over the Map: Navigate: Explore button again and review the instructions 
for navigating a 3D scene. 

22→ �Practice zooming, panning, tilting, and rotating the scene until you have mastered 
the 3D navigation tools.

22→ Return to the Crater Lake 3D bookmark when finished.

23→ �In the Contents pane (now showing the layers of the active Crater Lake_3D scene), 
click the Classes and Labels layer to make sure that the Feature Layer ribbon 
group is visible. Select the Appearance ribbon and examine the Visibility Range 
group. In 3D, the scale range is expressed in the viewer’s distance from the map.

Managing the placement of windows within the program area is an important skill. Currently a 
map view and a 3D scene view are open. Both views are docked in the same window, one atop 
the other, and clicking the view tabs at the top of the window switches between them. Views can 

Fig. 1.17. The Catalog pane

Source: Esri
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also be docked side by side. A docking icon (Fig. 1.18) controls 
where to place an object within a window: center, left, right, top,  
or bottom.

24→ �If necessary, resize the program interface to cover 
only part of the computer screen.

24→ �Click the Crater Lake_3D view tab above the scene 
and drag it down. The docking icon appears.

24→ �Drag the scene view to the left option and let go of 
the mouse button. The map view and scene view are 
placed side by side.

24→ �Click on the scene view tab again, drag it to the map, 
and choose a different docking option. Try them all.

24→ �Drag the scene away until no anchor icon is visible, and let go. The scene becomes 
a floating window.

Any window, whether it contains views (map and scene) or panes (Contents and Catalog), can be 
docked within the program area or moved to float on top of or outside it.

25→ �Click the Crater Lake view title and drag it off the program area so it becomes a 
floating window as well.

25→ �Click the Contents pane title and drag it off the program area, making it float.

25→ �Click the Catalog pane title and drag it off the program area, leaving it empty.

26→ �Drag the Crater Lake map view back to the program area, and notice that the cen-
ter of the program area is the only place to dock it. 

26→ �Drag the Crater Lake_3D scene view back to the program area and use the icon to 
dock it to the right of the map view.

26→ �Drag the Contents pane to the left edge of the program area and dock it there.

26→ �Drag the Catalog pane to the left edge and use the icon to dock it in the center, on 
top of the Contents pane. Use the tabs at the bottom of the pane to switch back and 
forth between the two panes.

To remove a tabbed pane from the window, it must first be converted to a floating window again.

26→ �Click the Catalog tab and drag 
it to make a new floating win-
dow. Then dock the window 
on the left edge of the program 
area.

26→ �Practice rearranging the win-
dows to master the docking 
techniques. When finished, 
leave the map and scene 
docked side by side. Place the 
Contents pane on the left and 
the Catalog pane on the right 
of the program area (Fig. 1.19).

The 2D maps and 3D scenes can be linked 
together for enhanced visualization.

Fig. 1.18. Docking icon

Source: Esri 

Fig. 1.19. Place the Contents pane on the left, 
the Catalog pane on the right, and the two views 
side by side in the middle.

Source: USGS/Esri
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27→ Click View: Link: Link Views > Center and Scale.

27→ Navigate in either the map or scene, and the other view updates to match.

27→ �Click the Crater Lake view tab at the top of the map. The tab turns blue, indicating 
it is the active map, and the Contents pane shows its layers.

27→ Click the Crater Lake_3D tab to activate it in order to view or modify its layers.

Rearranging panes can be done the same way as rearranging map and scene views. 

28→ Activate the Crater Lake map and click the Vents layer to highlight it.

28→ Click Feature Layer: Appearance: Drawing: Symbology.

28→ Experiment with rearranging the Symbology pane and the Catalog pane. 

TIP: If two panes are docked in the same window, appearing as tabs, a pane must be separated 
from the window before it can be docked elsewhere, by dragging the tab away.

 TIP: Panes have an Auto-Hide button that turns a pane into a tab along the program edge. 
When not in use, the pane folds away, conserving real estate for maps in the display area.

TIP: The Contents and Catalog panes are used often and are usually kept open. If needed, use the 
View: Windows group buttons to reopen them.

The flexibility of the interface makes it challenging to write instructions. The tutorials will not 
dictate how to arrange the windows unless it is important. You may need to independently turn 
layers on or off, or open and close windows and panes, as you complete the steps. Feel free to 
experiment to find the arrangements that work best for you.

Exploring project resources

The Catalog pane manages all the resources of a project, including the Maps entry already 
viewed. Now let’s examine some other resources.

29→ �Click the Catalog pane tab and make sure that the Project tab is selected, showing 
the contents of the project.

29→ �Expand the Toolboxes entry. Each project has a special toolbox for storing custom 
tools created by the user. This one is currently empty.

29→ �Expand Databases. It shows an icon labeled CraterLake or CraterLake.gdb, the 
home geodatabase that stores data sets related to this project.

29→ �Expand the CraterLake database to see the data inside. Mouse over each data set to 
see a description of the data type, and note the icon used to show it.

The home geodatabase is the default location where the project will save data by default. 
It is stored in the project folder. The CraterLake home geodatabase contains one table, two 
raster data sets, and eight vector feature classes. Geodatabases are presented in detail in 
Chapter 5.

TIP: The .gdb is called a file extension. Whether it appears or not depends on your computer’s 
settings. This book will not normally show the extension unless it is important to do so.
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2.	 List which feature class(es) contain point data and which contain line or polygon data. Also 
list which ones are rasters.

29→ �In the Catalog pane, expand the Styles entry to view the different symbol styles 
associated with this project.

29→ �Expand the Folders entry, which contains shortcuts to data sources used in the 
project. It currently shows one shortcut, the CraterLake project folder itself.

29→ �Use Project > Save or the Save icon on the Quick Access menu to save the  
project. It is smart to save the project periodically.

Vector feature classes, stored as points, lines, and polygons, include a table that stores 
information about each feature.

30→ Click on the Crater Lake view tab.

30→ �In the Contents pane, right-click the Vents layer and choose Attribute Table. (It 
may appear docked or floating; use your new skills to arrange it as desired.)

30→ Right-click the Faults layer and open its attribute table also.

30→ Close the tables when finished looking at them.

Layers have properties that can be viewed and set. Let’s examine some of them.

31→ In the Contents pane, right-click the Vents layer and choose Properties.

31→ �Click the General entry, which can be used to set the layer name and to provide 
another way to modify the visibility range discovered earlier.

31→ �Change the layer name to Volcanic Vents. This name is a cosmetic name for the 
layer only; it does not affect the stored data.

31→ �Click the Metadata entry. Ideally, a data set includes information about what it is 
and where it came from.

31→ �Click the Source entry. It gives basic information about the storage format and 
location of the data set (in the project’s home geodatabase).

31→ Click OK. Notice that the new name has appeared in the Contents pane.

The source of this data set is the CraterLake home geodatabase. The same data sets for vents, 
geology, and the lake are used in both the 2D and 3D maps. When a feature class is added to a 
map, it becomes a layer. Each layer has properties, such as the name you just modified, which 
are unique to the map or scene and can be set independently. 

3.	 Examine the vents’ layer name in the 3D scene. Did it update to match the changes made in 
the 2D map?

Group layers can be used to organize layers with a similar theme 
and make it easy to turn them on or off together. The Crater 

Lake Geology entry is an example of a group layer. It contains 
three individual layers: Crater Floor Geology, Classes and 

Labels, and Rock Types (Fig. 1.20).

32→ �Make sure the Crater Lake map view is active, and 
turn off the Lake layer.

32→ �Use the Crater Lake Geology check box to turn the 
group layer off, then on, and examine the effect 
on the map.

32→ Expand each of the layers in the group to see their legends.

Fig. 1.20. The Crater Lake 

Geology group layer

Source: EsriI
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32→ Examine the effects as the individual layers are turned off and on.

32→ Collapse the individual layers to hide the legends, but leave them all checked.

32→ Turn off the Crater Lake Geology group layer and the Hillshade layer.

TIP: To save space, hereafter “In the Contents pane” will be shortened to “In Contents.”

The bottom layer in Contents, Topographic, is known as the basemap. It is supplied by ArcGIS 
Online through an Internet connection, and it covers the whole world.

33→ Choose Map: Layer: Basemap > Imagery to switch to the Imagery basemap.

33→ �Zoom in. Notice that more detailed imagery with a higher resolution is now dis-
played. Zoom in to about 1:10,000 until individual trees are visible.

Basemaps use scale ranges to present appropriately detailed imagery at different map scales. 

TIP: Hold the Ctrl key and check or uncheck a visibility box to turn all the layers in the Contents 
off or on at the same time. This shortcut also works to expand or collapse all layers at once.

33→ Switch to the Crater Lake_3D scene and turn off all layers. 

33→ Switch to the Imagery basemap and explore the lake and Wizard Island.

We are going to work on one map at a time for a while. Let’s unlink this map and scene and fix 
any rotation present. Maps and scenes have properties and options that can be set for them.

34→ �Examine the View: Link: Link Views button; it should currently be blue, indicating 
that the views are linked (note the icons on the view tabs, which also indicate linkage). 

34→ �Click the Link Views button to remove the link.

34→ Close the Crater Lake_3D scene by clicking the x on its view tab.

34→ In Contents, right-click the icon for the Crater Lake map and choose Properties.

34→ Click the General section. Change the Rotation setting to 0. Click OK.

34→ Click Map: Layer: Basemap > USGS National Map.

TIP: Click the compass North arrow in a scene to quickly reorient the scene to north up.

Setting map symbols

The Symbology pane modifies the symbols used to display map layers.

35→ �In Contents, make sure the Volcanic Vents layer is highlighted, and click Feature 

Layer: Appearance: Drawing: Symbology. The Symbology pane opens.

35→ In the Symbology pane, leave the Symbology set to Single Symbol.

35→ �Click on the symbol representation (black triangle) to open the Format Point 
Symbol pane. Note that it has two tabs: a Gallery for selecting the base symbol and 
Properties for modifying how the symbol appears.

35→ �In the Gallery tab, choose a different symbol, such as Diamond 3. The map updates 
to the new symbol.

35→ Click on the Properties tab and examine the symbol settings (Fig. 1.21).

The Format Point Symbol pane is an example of packing many options into a small space. It has 
three different panels, as indicated by the icons (hover over each icon to see its title). 
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35→ �Click the icon for each panel and examine 
the settings available in each.

35→ �Select the first panel, named Symbol. Ex-
pand both entries, Appearance and Halo, 
and view their settings.

35→ �Change the color, size, or angle of the sym-
bol, and then click Apply for the changes to 
take effect on the map.

36→ �To start over, click on the Gallery tab to 
return to the array of symbols. 

36→ �Use the Gallery and Properties tabs to make 
the symbols 12-pt. pink stars.

36→ �Click the circled arrow to return to the main 
Symbology pane.

36→ �Close the Symbology pane by clicking the x 
in its upper-right corner.

The symbol settings can be accessed more than one way.

37→ �In Contents, right-click the Volcanic Vents 
layer name to open a context menu. Choose 
the Symbology entry in the menu to open the Symbology pane. 

37→ �In Contents, left-click the Vents layer symbol to open the Format Point Symbol tab 
of the Symbology pane.

37→ �In Contents, right-click the Vents layer symbol to select a different color. 

37→ �Close the Symbology pane. We will learn more about it in Chapter 2. 

TIP: Watch for different ways of accessing the same functions. Once a command or pane has been in-
troduced and used several times, the tutorial instructions will simply say to open it, not how to open it.

Working with local GIS data

To work with data outside the project folder, we must create a link, or folder connection, to it. We 
will add a link to use other data that came with this book.

38→ �Click Insert: Project: Add Folder.

38→ Click on the C:\ drive and navigate into the gisclass folder (wherever you placed it).

38→ �Click the mgisdata folder to highlight it (don’t double-click and go inside it) and 
choose OK.

38→ �In the Catalog pane, expand the Folders entry to see the CraterLake project folder 
and the mgisdata folder. (Collapse the other entries if desired.)

38→ �This mgisdata folder will be used many times. Right-click it and choose Add to Favor-
ites to make it easily accessible in other projects from the Catalog Favorites tab.

39→ Expand the mgisdata folder to see subfolders of data, organized geographically.

39→ �Expand the Oregon folder and find the oregondata geodatabase. Expand it to see 
its contents.

39→ Click and drag the counties feature class on top of the Crater Lake map.

39→ Zoom in/out until several of the counties around Crater Lake appear in the map.

Fig. 1.21. Formatting point symbols

Source: Esri
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40→ �In Contents, click the counties layer to  
highlight it and use Feature Layer:  

Appearance: Drawing: Symbology  
to open the Symbology pane.

40→ �Click the Symbol representation to open the 
Format Polygon Symbol pane.

40→ �In the Gallery tab, type hollow in the Search 
box and click Enter. Choose the Extent  
Hollow symbol.

40→ �Switch to the Properties tab and set the out-
line color to hot pink. Click Apply.

41→ �Zoom in and compare the counties boundary 
with the basemap (Fig. 1.22).

41→ �In Contents, right-click the counties layer 
and choose Properties (or simply dou-
ble-click counties).

41→ �Read the information in the Metadata sec-
tion and then close the properties.

This example illustrates the importance of source scale. 
The metadata state that counties came from a generalized data set, optimized for quickly drawing 
national maps, so it has lower resolution and accuracy than the basemap.

Dragging data from the Catalog pane to the map is one way to add data, but there is another.

42→ Click Map: Layer: Add Data. Click the Folders entry to find the mgisdata folder. 

42→ �Navigate inside mgisdata to find the Oregon\OregonStateGeology\geology feature 
class. Select it and click OK to add it to the map.

42→ �Compare this geology layer with the Crater Lake Geology group by zooming to 
Crater Lake and turning the geology layer off and on. Leave it off when done.

42→ �In Contents, right-click the counties layer and choose Zoom to Layer. Check the 
scale reading.

Most data sets in the Oregon geodatabase were designed for use at the state scale, about 
1:3,000,000. The pink counties appear adequate now. The Crater Lake data sets were compiled 
at scales around 1:24,000. When viewed at the state scale, the lake is hardly visible. The original 
source scale of a data set matters and should be considered when searching for data. 

Since the Crater Lake and Oregon data sets are not suitable for use together, we will create a new 
map to continue exploring GIS data.

43→ �In Contents, right-click the geology layer and choose Remove. Also remove the 
counties layer.

43→ �Right-click the Crater Lake Geology layer and choose Zoom to Layer.

43→ Close the Crater Lake map and save the project.

43→ Choose Insert: Project: New Map.

43→ �In Contents, find the map’s icon and click the Map title next to it twice, slowly, to 
enable editing.

43→ Type Oregon for the map name and click Enter.

Fig. 1.22. Difference in county 
source scales

Source: Esri
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44→ �Use Map: Layer: Add Data or the Catalog pane to add the counties feature class 
from mgisdata\Oregon\oregondata to the map.

44→ �In Contents, click twice slowly on the counties layer name and change it to Counties.

44→ �Use the Feature Layer: Appearance ribbon or right-click the Counties layer to 
open the Symbology pane.

44→ �Give the Counties layer a hollow symbol with a green outline color.

TIP: We will be using the Symbology pane extensively, so keep it open. Be sure to have the appro-
priate layer highlighted before changing symbols.

45→ In the Catalog pane, expand the Transportation “folder” in the oregondata geodatabase. 

45→ �Click the airports feature class; then hold down the Ctrl key and click on the  
highways feature class so that both are selected. Drag them to the map.

45→ Symbolize highways with a brown line and airports with an airport symbol.

46→ �Add the parks feature class from the oregondata geodatabase. Symbolize it with 
light green fill and a dark green outline.

46→ �Add the hospitals feature class from the oregondata geodatabase. Symbolize it 
using a thick cross symbol with blue fill and (extra points) a gray outline.

Using ArcGIS Online content

One of the benefits of ArcGIS Pro is its link to ArcGIS Online, which offers extensive data 
resources, including industry-authored content and information contributed by ordinary users. 
Online content is accessed through the Portal pane.

47→ �In the Catalog pane, switch from the Project tab to the Portal tab by clicking the 
Portal heading.

47→ �Examine the icons below the heading and hover over each one to view the titles: 
My Content, My Favorites, My Groups, and so on.

Several of these icons access content that you have saved in your ArcGIS Online account. 
The ArcGIS Online icon searches the entire AGOL holdings. The Living Atlas icon accesses 
authoritative industry-authored content (for users with an AGOL subscription account).

TIP: Online content is transient, and the specific items mentioned in this tutorial may change or 
disappear. If an item can’t be found, look for something similar and use it instead. The important 
thing is to learn to search for, evaluate, and use content.

47→ Click the ArcGIS Online icon and type Oregon in the search box. Click Enter.

47→ Notice the different icons representing different types of data services.

47→ Hover over an item to see a pop-up description.

47→ �Note the data location entry in the description. This is the URL of the service  
providing the data. 

TIP: If a URL begins with http://www.arcgis.com/, then it is probably an ArcGIS Online published 
service. If it begins with anything else, it is probably an ArcGIS Portal installation run by a 
government or company.
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48→ �Edit the search term to Oregon colleges and 
click Enter (Fig. 1.23). Look for a web map 
icon—for example, Oregon Community Col-

leges. Hint: Click the Sort button and choose 
Relevance for best results.

48→ �Maps cannot be dragged in; they must be 
opened. Right-click a map icon and choose 
Add and Open. A new map, linked to the  
online data, is added to the project.

48→ �Choose Map: Navigate: Explore: Topmost 

Layer.

48→ �Click on one of the map symbols. A pop-up 
opens with information about the feature 
clicked.

48→ �In Contents, double-click the map icon to open 
the map properties. Click the Metadata section.

ArcGIS Online requires a minimum set of metadata for 
an item to be published. The quality of description is 
sometimes a clue to the authority of the data set. Like 
everything else on the Internet, one should be cautious in 
accepting data at face value.

Layers in a web map are services and can be copied to a 
different map, including the Oregon map we previously created. 

49→ Close the map properties.

49→ Right-click one of the web map layers and choose Copy.

49→ Switch to the Oregon map, right-click the map icon at the top, and choose Paste.

Labels can provide more information on a map.

50→ In Contents, click the Counties layer to select it.

50→ �Examine the Feature Layer: Labeling: Label Class group. Note that the label 
field is currently set to NAME.

50→ �Click the Label button next to it to make the labels appear. (We’ll learn more about 
setting other label options later.)

50→ Turn off the labels by clicking the Label button again.

50→ In Contents, click the airports layer to select it. Turn its labels on.

51→ �In the Catalog pane, in the current ArcGIS Online search list, look for symbols 
representing a feature layer, and drag one into the map.

51→ �Feature layers are often composed of group layers. In Contents, expand the  
feature layer, if needed, until the individual layers appear.

51→ �Right-click an individual layer and choose Attribute Table. Feature layers behave 
similarly to feature classes.

Let’s explore the Living Atlas (if you don’t have a subscription account, skip to Step 55).

TIP: Try using the Filter option in the Catalog pane search box to filter the results by Item  
Type > Layers > Imagery Layers.

Fig. 1.23. Searching for Oregon 
colleges

Source: Esri
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52→ In the Catalog pane, click the last icon to open the Living Atlas panel.

52→ �Type temperature in the search box and click Enter.

52→ Find an imagery layer icon titled USA Mean Temperature and drag it to the map.

Unlike a basemap, feature layers and imagery layers provide actual features or pixel values, not 
a pre-rendered snapshot of a map. A user can change the symbols and use the data for analysis.

53→ �In Contents, right-click the USA Mean Temperature layer and choose 
Symbology.

53→ Change the color scheme to a blue-red ramp so it looks more like temperatures.

53→ �In Contents, double-click the USA Mean Temperature layer and view the Metadata 
section. Skim the entire entry. This is well-documented data.

4.	 Construct a citation for the USA Mean Temperature service. Consult both the metadata and 
the pop-up window in the Portal pane to find all the information needed.

TIP: Internet services can be slow, depending on network connection speed. They can also go 
down and not work at times. If one service doesn’t work, try another.

54→ Close the layer properties window.

54→ In the Catalog pane, change the search term to traffic and click Enter.

54→ �Find a map image layer icon labeled World Tra�c Service and add it to the map.

54→ �Turn off the other layers (except the basemap) to see the traffic map better. Zoom 
into the Portland area.

This layer portrays a real-time map service showing current traffic conditions. Zoom close in to 
see the local streets light up with information.

54→ �Zoom to the extent of Oregon again, and turn on the Counties layer if needed.

54→ �Save the project.

We used four types of AGOL services in this exercise (web map, feature layer, imagery layer, 
and map image layer), but you’ll need to learn more about data formats to understand how they 
differ. We will tackle this material in Chapter 12.

Using geoprocessing

GIS includes more than creating maps; it also provides tools for analyzing map data. Analysis 
functions and many data management functions are executed as geoprocessing tools.

55→ �In Contents, turn off all layers except the basemap and Counties.

55→ �Choose Analysis: Geoprocessing: Tools to open the Geoprocessing pane.

55→ �Examine the three tabs at the top of the window, and click each one in turn.

The Favorites tab keeps a list of frequently used tools. The Toolboxes tab shows all tools 
organized into toolsets. The Portal pane shows tools that run as services on ArcGIS Online; these 
tools typically require a subscription account and consume service credits. We would like to 
gather some statistics about the county populations in Oregon to find the largest, smallest, and 
average population of the counties.

TIP: The Geoprocessing and Catalog panes are used often. Try docking them one atop the other 
in a single window. Leave the window open to easily switch back and forth. 
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55→ �In the Geoprocessing pane, click the Favor-
ites panel again.

55→ �Enter statistics in the search box.

55→ �Mouse over the Summary Statistics tool to 
learn what it does. 

55→ �Click the Summary Statistics tool to open it 
(Fig 1.24)

The Parameters tab provides the information the tool 
needs to run. Items marked with an asterisk are required; 
the others will not be used or will contain default values. 

55→ �Hover over the blue-circled question mark 
to see the short description of the tool. Then 
click the circle to open the tool Help in a 
browser window. Minimize the browser.

55→ �Hover near a parameter box; a circled “i” 
will appear. Hover over the “i” to see a de-
scription of the parameter.

This tool produces an output table containing the statistics. 
By default, outputs are placed in the project’s home 
geodatabase. Give all outputs descriptive names that 
indicate their contents.

56→ �For Input Table, choose Counties from the 
drop-down (the Browse button is only needed if the data are not already in the map).

56→ �Click in the Output Table box to see the full location and name.

56→ �Edit the final part of the name after the last “\” to read OregonCountyPopStats. 
Click Tab to finish entering the name.

56→ �Use the Field drop-down box to select the field POP2014. Leave Sum as the  
Statistic Type.

56→ �Use the second Field drop-down and select POP2014 again. Change the Statistic 
Type to Minimum.

56→ Add entries for the maximum and mean of POP2014 as well.

56→ Leave the Case field blank. The tool should appear as in Figure 1.24.

56→ Click Run at the bottom of the pane to execute the tool.

57→ In Contents, find the new table near the bottom under Standalone Tables.

57→ Right-click the OregonCountyPopStats table and choose Open.

57→ Examine the statistics.

5.	 How many counties does Oregon have? What is the average population?

We can sort the original table to find which counties have the smallest and largest populations.

57→ In Contents, right-click the Counties layer and choose Attribute Table.

57→ Right-click the POP2014 field heading and choose Sort Ascending.

6.	 List the smallest and largest counties with their 2014 populations.

Fig. 1.24. The Summary Statistics tool

Source: Esri


